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1 Avant-propos
Le module de sécurité SY6 ajoute aux servo-variateurs de la gamme SC6 et SI6 les fonctions de sécurité Safe Torque Off
(STO) et Safe Stop 1 (SS1), toutes deux décrites dans la norme EN 61800-5-2.

Dans un servo-variateur, la fonction de sécurité STO empêche immédiatement après son activation la génération d'un
champ tournant électrique indispensable au fonctionnement des moteurs synchrones et asynchrones. Dans le cas de la
fonction SS1-t, l'arrêt a lieu après une durée configurable.

Les fonctions de sécurité STO et SS1 sont commandées via EtherCAT (FSoE) dans le cas de la combinaison servo-variateur et
module de sécurité SY6.

SY6 qui est une solution entièrement électronique se distingue par un fonctionnement rapide et sans usure. Le module de
sécurité est conçu de telle manière que les tests du système, qui interrompaient régulièrement la production,
appartiennent désormais au passé. Dans la pratique, cela se traduit par une disponibilité accrue des machines et des
installations. De plus, la planification et la documentation bien souvent très complexes des essais de fonctionnement
deviennent superflues.

Les servo-variateurs avec module de sécurité intégré peuvent être utilisés dans les systèmes complexes du point de vue de
la technique de sécurité jusqu'à SIL 3, PL e, catégorie 4. La conformité avec les exigences normatives a été contrôlée par un
organisme de contrôle indépendant dans le cadre d'un examen CE de type.

Les servo-variateurs des gammes SC6 et SI6 ont réussi aux tests de conformité EtherCAT et Fail Safe over EtherCAT (FSoE)
au cours desquels l'interface de communication a été testée dans le but de garantir la fiabilité et la fonctionnalité,
indépendamment du fabricant, de la communication sous-jacente.
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2 Informations utilisateur
La présente documentation contient toutes les informations relatives à l’utilisation conforme à l'emploi prévu du servo-
variateur en combinaison avec le module de sécurité SY6.

Avis concernant le genre

Par souci de lisibilité, nous avons renoncé à une différenciation neutre quant au genre. Les termes correspondants
s'appliquent en principe aux deux sexes au titre de l'égalité de traitement. Les tournures abrégées ne portent par
conséquent aucun jugement de valeur, mais sont utilisées à des fins rédactionnelles uniquement.

2.1 Conservation et remise à des tiers
Comme la présente documentation contient des informations importantes à propos de la manipulation efficiente et en
toute sécurité du produit, conservez-la impérativement, jusqu’à la mise au rebut du produit, à proximité directe du produit
en veillant à ce que le personnel qualifié puisse la consulter à tout moment.

En cas de remise ou de vente du produit à un tiers, n’oubliez pas de lui remettre la présente documentation.

2.2 Produit décrit
La présente documentation est contraignante pour les :

Servo-variateurs de la gamme SC6 ou SI6 en combinaison avec le module de sécurité SY6 et le logiciel DriveControlSuite
(DS6) à partir de V 6.6-B et le micrologiciel correspondant à partir de V 6.6-B-EC.

2.3 Normes
Les normes européennes suivantes s'appliquent au produit spécifié dans la présente documentation :

§ EN ISO 13849-1:2015

§ EN ISO 13849-2:2012

§ EN 61800-5-2:2017

§ EN 61508-x:2010

§ EN 60204-1:2018

§ EN 62061:2005 + Cor.:2010 + A1:2013 + A2:2015

§ CEI 61784-3:2010

Pour une meilleure lisibilité, nous ne précisons pas l’année respective des renvois aux normes ci-après.

2.4 Déclaration de conformité UE
Nous, la société STÖBER Antriebstechnik GmbH + Co. KG, déclarons que les produits décrits dans le présent document
répondent aux exigences des directives du Parlement européen et du Conseil européen.

Vous trouverez une déclaration de conformité UE intégrale et spécifique à chaque produit sous 
http://www.stoeber.de/fr/download ou gratuitement auprès de notre service.

2.5 Actualité
Vérifiez si le présent document est bien la version actuelle de la documentation. Vous pouvez télécharger les versions les
plus récentes de documents relatives à nos produits sur notre site Web : 
http://www.stoeber.de/fr/download.

http://www.stoeber.de/fr/download
http://www.stoeber.de/fr/download
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2.6 Langue originale
La langue originale de la présente documentation est l’allemand ; toutes les versions en langues étrangères ont été
traduites à partir de la langue originale.

2.7 Limitation de responsabilité
La présente documentation a été rédigée en observant les normes et prescriptions en vigueur et reflète l'état actuel de la
technique.

STOBER exclut tout droit de garantie et de responsabilité pour les dommages résultant de la non-observation de la
documentation ou d'une utilisation non conforme du produit. Cela vaut en particulier pour les dommages résultant de
modifications techniques individuelles du produit ou de sa planification et de son utilisation par un personnel non qualifié.
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2.8 Conventions de représentation
Afin que vous puissiez rapidement identifier les informations particulières dans la présente documentation, ces
informations sont mises en surbrillance par des points de repère tels que les mentions d’avertissement, symboles et
balisages.

2.8.1 Représentation des avertissements et informations
Les avertissements sont indiqués par des symboles. Ils attirent l'attention sur les dangers particuliers liés à l'utilisation du
produit et sont accompagnées de mots d'avertissement correspondants qui indiquent l'ampleur du danger. Par ailleurs, les
conseils pratiques et recommandations en vue d'un fonctionnement efficient et irréprochable sont également mis en
surbrillance.

PRUDENCE

Prudence

signifie qu’un dommage matériel peut survenir

▪ lorsque les mesures de précaution mentionnées ne sont pas prises.

ATTENTION !

Attention

La présence d’un triangle de signalisation indique l’éventualité de légères blessures corporelles

▪ lorsque les mesures de précaution mentionnées ne sont pas prises.

AVERTISSEMENT !

Avertissement

La présence d’un triangle de signalisation indique l’éventualité d’un grave danger de mort

▪ lorsque les mesures de précaution mentionnées ne sont pas prises.

DANGER !

Danger

La présence d’un triangle de signalisation indique l’existence d’un grave danger de mort

▪ lorsque les mesures de précaution mentionnées ne sont pas prises.

Information

La mention Information accompagne les informations importantes à propos du produit ou la mise en surbrillance d’une
partie de la documentation, qui nécessite une attention toute particulière.
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2.8.2 Conventions typographiques
Certains éléments du texte courant sont représentés de la manière suivante.

Information importante Mots ou expressions d'une importance particulière

Interpolated position mode En option : nom de fichier, nom de produit ou autres noms

Informations complémentaires Renvoi interne

http://www.musterlink.de Renvoi externe

Affichages logiciels et écran

Les représentations suivantes sont utilisées pour identifier les différents contenus informatifs des éléments de l'interface
utilisateur logicielle ou de l'écran d'un servo-variateur ainsi que les éventuelles saisies utilisateur.

Menu principal 
Réglages

Noms de fenêtres, de boîtes de dialogue et de pages ou boutons cités
par l'interface utilisateur, noms propres composés, fonctions

Sélectionnez 
Méthode de référençage A

Entrée prédéfinie

Mémorisez votre 
<Adresse IP propre>

Entrée personnalisée

ÉVÉNEMENT 52 : 
COMMUNICATION

Affichages à l'écran (état, messages, avertissements, dérangements)

Les raccourcis clavier et les séquences d'ordres ou les chemins d'accès sont représentés comme suit.

[Ctrl], [Ctrl] + [S] Touche, combinaison de touches

Tableau > Insérer tableau Navigation vers les menus/sous-menus (entrée du chemin d'accès)

2.8.3 Mathématiques et formules
Pour l'affichage de relations et formules mathématiques, les caractères suivants sont utilisés.

– Soustraction

+ Addition

× Multiplication

÷ Division

| | Valeur absolue

http://www.stoeber.de
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2.9 Marques
Les noms suivants utilisés en association avec l’appareil, ses options et ses accessoires, sont des marques ou des marques
déposées d’autres entreprises :

EtherCAT®,
Safety over EtherCAT®

EtherCAT® and Safety over EtherCAT® sont des marques déposées et des
technologies brevetées sous licence de Beckhoff Automation GmbH, Allemagne.

TwinCAT® TwinCAT® est une marque déposée et sous licence de Beckhoff Automation GmbH,
Allemagne.

Toutes les autres marques qui ne sont pas citées ici sont la propriété de leurs propriétaires respectifs.

Les produits enregistrés comme marques déposées ne sont pas identifiés de manière spécifique dans la présente
documentation. Il convient de respecter les droits de propriété existants (brevets, marques déposées, modèles déposés).

2.10 Explication des termes
En raison de la référence aux normes pertinentes et aux produits d'autres fabricants, vous rencontrerez dans cette
documentation différentes désignations spécifiques aux fabricants ou aux normes pour le même terme.

Pour une meilleure compréhension, les désignations dans cette documentation ont été normalisées autant que possible à
la terminologie spécifique à STOBER. Veuillez vous référer au tableau ci-dessous pour la correspondance entre les
désignations STOBER et les autres sources.

STOBER EtherCAT FSoE

Commande MainDevice EtherCAT MainInstance FSoE

Servo-variateur SubDevice EtherCAT SubInstance FSoE

Tab. 1: Correspondance de la terminologie STOBER relative à EtherCAT et FSoE
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3 Consignes de sécurité

AVERTISSEMENT !

Danger de mort en cas de non-respect des consignes de sécurité et des risques résiduels !

Le non-respect des consignes de sécurité et des risques résiduels figurant dans la documentation du servo-variateur peut
provoquer des accidents entraînant des blessures graves ou la mort.

▪ Respectez les consignes de sécurité figurant dans la documentation du servo-variateur.

▪ Tenez compte des risques résiduels lors de l'évaluation des risques relative à la machine ou l'installation.

AVERTISSEMENT !

Dysfonctionnement de la machine suite à un paramétrage erroné ou modifié !

Si le paramétrage est erroné ou modifié, des dysfonctionnements peuvent survenir sur les machines ou les installations et
entraîner des blessures graves ou la mort.

▪ Respectez les consignes de sécurité figurant dans la documentation du servo-variateur.

▪ Protégez par exemple le paramétrage contre tout accès non autorisé.

▪ Prenez les mesures appropriées pour d'éventuels dysfonctionnements (par exemple, arrêt d'urgence contrôlé ou
arrêt d'urgence).

3.1 Personnel qualifié
Dans le cadre de l’exécution des tâches expliquées dans la présente documentation, les personnes chargées de ces tâches
doivent disposer des qualifications professionnelles inhérentes et être en mesure d’évaluer les risques et dangers résiduels
liés à la manipulation des produits. C’est la raison pour laquelle tous les travaux sur les produits, ainsi que leur utilisation et
leur élimination, sont strictement réservés à un personnel qualifié.

Par personnel qualifié on entend les personnes ayant reçu l'autorisation d'exécuter les tâches mentionnées, soit par une
formation de technicien, soit après avoir suivi une initiation dispensée par des personnes qualifiées.

Par ailleurs, il incombe de lire attentivement, comprendre et respecter les dispositions en vigueur, les prescriptions légales,
les règlements applicables, la présente documentation ainsi que les consignes de sécurité inhérentes.
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3.2 Utilisation conforme
Le module de sécurité SY6 peut être combiné avec les servo-variateurs STOBER de la gamme SC6 ou SI6.

En cas d'utilisation d'un servo-variateur avec le module de sécurité intégré SY6 au sein d'une application liée à la sécurité, le
module de sécurité doit impérativement être contrôlé par un relais de sécurité ou une commande de sécurité.

DANGER !

Tension électrique ! Danger de mort par choc électrique !

Une fonction de sécurité STO activée signifie uniquement une génération du champ tournant interrompue au niveau du
moteur. De hautes tensions dangereuses peuvent encore y être présentes.

▪ Veillez à ne pas toucher les pièces sous tension.

▪ Lorsqu'il s'avère nécessaire de couper la tension d'alimentation, observez les exigences de la norme EN 60204-1.

Utilisation non conforme à l'usage prévu

Il est interdit d'utiliser le module de sécurité en dehors du servo-variateur ou des spécifications techniques applicables.

Information

Le module de sécurité SY6 ne permet pas de réaliser un arrêt d’urgence contrôlé selon EN 60204-1 ! 
Veuillez observer cette norme pour la différenciation entre Arrêt d'urgence contrôlé et Arrêt d'urgence en liaison avec Safe
Torque Off.

Modification

En votre qualité d'utilisateur, il vous est interdit de modifier la construction et les caractéristiques techniques ou électriques
du module de sécurité SY6. Il est interdit de retirer le module du servo-variateur, de le réparer ou de le remplacer soi-
même.

Maintenance

Le module de sécurité est sans entretien.

3.3 Mise hors service
Dans le cas d'applications de sécurité, notez le temps de mission TM = 20 ans dans les caractéristiques techniques relatives à
la sécurité. Un servo-variateur avec module de sécurité intégré doit être mis hors service 20 ans après la date de
production. La date de fabrication d'un servo-variateur est indiquée sur la plaque signalétique correspondante.
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4 Module de sécurité SY6
Le module de sécurité SY6 ajoute les fonctions de sécurité STO (Safe Torque Off) et SS1 (Safe Stop 1) au servo-variateur. Le
module empêche la formation d'un champ tournant dans le bloc de puissance du servo-variateur et fait passer
immédiatement ou de manière temporisée (SS1-t) le servo-variateur à l'état STO en présence d'une erreur ou sur requête
externe.

Caractéristiques

§ Fonctions de sécurité réalisables :

• Couple déconnecté en toute sécurité – STO selon EN 61800-5-2

• Catégorie d’arrêt 0 selon EN 60204-1

• Arrêt sûr 1 (temporisé) – SS1-t conformément à EN 61800-5-2

• Catégorie d’arrêt 1 selon EN 60204-1

§ Commande des fonctions de sécurité via Safety over EtherCAT (FSoE)

§ Temps de coupure STO : < 50 ms

§ Sans usure

Certifications conformément à EN 61800-5-2 et EN ISO 13849-1

§ Safety Integrity Level  (SIL) 3

§ Performance Level  (PL) e

§ Catégorie 4
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5 Structure du système et principe de fonctionnement
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Fig. 1: Composants du concept de sécurité basé sur FSoE

Composants du système

Les principaux composants de ce concept de sécurité basé sur FSoE sont :

§ Servo-variateurs avec module de sécurité intégré SY6
... pour la réalisation des fonctions de sécurité STO et SS1-t

§ Commande (API) avec MainDevice EtherCAT intégré
... pour l'organisation de l'ensemble de la communication réseau

§ Coupleur de bus (coupleur EtherCAT)
... comme lien entre la commande et la commande de sécurité ; le coupleur de bus transmet les télégrammes de la
commande de sécurité au MainDevice EtherCAT

§ Commande de sécurité (S-SPS) avec MainInstance FSoE intégré
... pour la communication FSoE ainsi que la liaison logique des participants FSoE ; la commande de sécurité comporte
des modules de sécurité certifiés qui peuvent être configurés en fonction de l'application à l'aide d'un logiciel
d'automatisation approprié

§ Raccordements sécurisés avec des entrées et des sorties numériques à sécurité intégrée
... pour le raccordement de capteurs de sécurité 24 VCC comme par exemple les interrupteurs d'arrêt d'urgence ou de
position, les barrages photoélectriques, tapis de contact, etc.

§ Protocole FSoE
... pour la transmission des données de sécurité

§ EtherCAT
... comme système de bus de terrain sous-jacent
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Principe de fonctionnement

La pièce de commande du servo-variateur génère un modèle d'impulsions (PWM) en vue de la génération d'un champ
tournant sur le module IGBT du bloc de puissance. Ce champ tournant est nécessaire au fonctionnement de moteurs
synchrones et asynchrones.

Si la fonction de sécurité STO est inactive, le module de sécurité SY6 autorise la génération du champ tournant dans le bloc
de puissance ; le moteur raccordé peut générer un champ tournant. Si la fonction de sécurité est active, le module de
sécurité bloque la génération du champ tournant dans le bloc de puissance et le servo-variateur ne parvient pas à générer
un couple dans le moteur raccordé.

Le module de sécurité SY6 représente un SubInstance FSoE. Ce dernier échange les informations de commande et d'état
avec le MainInstance FSoE via le MainDevice EtherCAT selon le principe Black-Channel. Le SubInstance décompresse les
données de sécurité, les plausibilise et autorise/bloque les deux canaux de sécurité dans le bloc de puissance.

Les fonctions de sécurité STO et SS1-t se rapportent à l'appareil et ne sont pas spécifiques aux axes. Dans le cas de
régulateurs double axe, les deux axes sont simultanément mis dans l'état sûr. Une SS1-t activée ne peut pas être annulée.

DANGER !

Danger de mort sous l'effet d'axes verticaux soumis à la force de gravité de l'arrêt par inertie du moteur !

Lorsque la fonction de sécurité STO est activée, le servo-variateur ne parvient pas à générer de couple à l'intérieur du
moteur. Dans un tel cas, les axes verticaux soumis à la force de gravité risquent de s'affaisser. Si le moteur venait à se
déplacer en cas d'activation d'une fonction STO, il s'arrête par inertie de manière non contrôlée.

▪ Sécurisez les axes verticaux soumis à la force de gravité à l'aide de freins ou de mesures similaires.

▪ Assurez-vous que l'arrêt par inertie du moteur n'engendre aucun danger.

AVERTISSEMENT !

Surcourse prolongée ! Mouvement résiduel !

Le bloc de sécurité ne peut pas empêcher une défaillance de la partie fonctionnelle du servo-variateur (p. ex. en cas de mise
à l'arrêt commandée) pendant l'exécution de la fonction de sécurité SS1-t. D'où l'impossibilité d'utiliser SS1-t lorsque cette
défaillance est susceptible de provoquer une situation dangereuse dans l'application finale. Tenez compte de ce fait lors de
la planification.

En cas d'erreur dans le bloc de puissance du servo-variateur – bien que la fonction STO soit active – un passage de courant
statique est possible dans le moteur, l'arbre du moteur pouvant ici se déplacer, au maximum, de l'angle 360° ÷ (p × 2).
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6 Caractéristiques techniques
Les conditions de transport, de stockage et de fonctionnement du module de sécurité correspondent à celles du servo-
variateur. Les caractéristiques techniques font partie du manuel du servo-variateur (voir 
Informations complémentaires [} 63]).

Le tableau ci-dessous contient les indicateurs du module de sécurité SY6 déterminants pour la technique de sécurité.

SIL CL 3

SIL 3

PL e

Catégorie 4

PFHD 5 × 10-9 [1/h]

Temps de mission (TM) 20 ans

Temps d'arrêt STO < 50 ms

Temporisation SS1 10 – 655350 ms (± 1 %)

Tab. 2: SY6 – Indices déterminants pour la technique de sécurité
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7 Bon à savoir avant la mise en service
Les chapitres ci-après vous aident dans la mise en place rapide de l'interface programme avec les désignations de fenêtre
correspondantes et vous fournissent les informations importantes concernant les paramètres et l'enregistrement général
de votre planification.

7.1 Interfaces programme
Les chapitres suivants contiennent les interfaces programme des composants logiciels décrits.

7.1.1 Interface programme DS6
Le logiciel de mise en service DriveControlSuite (DS6) offre une interface utilisateur graphique pour la planification, le
paramétrage et la mise en service rapides et efficaces de votre projet d'entraînement. Si une situation de maintenance se
présente, vous pouvez analyser les informations de diagnostic telles que les états de service, la mémoire des dérangements
et le compteur de dérangements de votre projet d'entraînement à l'aide de DriveControlSuite.

Information

L'interface programme de DriveControlSuite est disponible en allemand, en anglais et en français. Pour changer la langue de
l'interface programme, sélectionnez le menu Réglages > Langue.

Information

Vous pouvez accéder à l'aide de DriveControlSuite dans la barre de menus en cliquant sur Menu Aide > Aide sur DS6 ou via
la touche [F1] de votre clavier. En fonction de la zone de programme dans laquelle vous appuyez sur [F1], une rubrique
d'aide correspondant au thème s'ouvre.

1 2

3

4

5

6 7 8
9

Fig. 2: DS6 : interface programme
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N° Zone Description

1 Barre de menus Les menus Fichier, Affichage, Réglages et Fenêtre peuvent être utilisés pour ouvrir et
enregistrer les projets, afficher et masquer les fenêtres de programme, sélectionner la
langue d'interface et les différents niveaux d'accès et naviguer entre les différentes
fenêtres dans la zone de travail.

2 Barre d'outils La barre d'outils vous permet d'accéder rapidement aux fonctions fréquemment utilisées,
telles que l'ouverture et l'enregistrement de projets ainsi que l'affichage et le masquage de
fenêtres dans l'interface programme.

3 Arborescence de
projet

L'arborescence de projet représente la structure de votre projet d'entraînement sous la
forme de modules et de servo-variateurs. Sélectionnez dans un premier temps un élément
dans l'arborescence de projet afin de pouvoir le traiter dans le menu de projet.

4 Menu de projet Le menu de projet comprend différentes fonctions de traitement du projet, du module et
des servo-variateurs. Le menu de projet s'adapte à l'élément que vous avez sélectionné
dans l'arborescence de projet.

5 Zone de travail Les différentes fenêtres que vous pouvez utiliser pour traiter votre projet d'entraînement,
telles que la boîte de dialogue de planification, les assistants, la liste des paramètres ou
l'outil d'analyse Scope, s'ouvrent dans la zone de travail.

6 Contrôle des
paramètres

Le contrôle des paramètres détecte les anomalies et les incohérences constatées lors du
contrôle de plausibilité des paramètres calculables.

7 Messages Les entrées dans les messages documentent l'état de connexion et de communication des
servo-variateurs, les entrées erronées interceptées par le système, les erreurs survenues
lors de l'ouverture d'un projet ou les infractions aux règles dans la programmation
graphique.

8 Listes de paramètres
variables

Vous pouvez utiliser les listes de paramètres variables pour regrouper des paramètres
quelconques en vue d'un aperçu rapide dans des listes de paramètres individuelles.

9 Barre d'état La barre d'état comporte des informations sur la version logicielle et, lors de processus
comme le chargement de projets, des informations complémentaires sur le fichier de
projet, les appareils et la progression du processus.

7.1.1.1 Configurer la vue

Vous pouvez modifier la visibilité et la disposition des zones et des fenêtres dans DriveControlSuite, par exemple pour
optimiser l'espace disponible dans la zone de travail lorsque vous travaillez sur des écrans plus petits.

Afficher/masquer les zones

Utilisez les icônes de la barre d'outils ou les entrées du menu Vue pour afficher ou masquer certaines zones dans
DriveControlSuite selon vos besoins.

Icône Entrée Description

– Réinitialiser Réinitialise la vue aux paramètres d'usine.

Projet Affiche/masque la fenêtre Projet (arborescence de projet,
menu de projet).

Messages Affiche/masque la fenêtre Messages.

Contrôle des paramètres Affiche/masque la fenêtre Contrôle des paramètres.

Listes de paramètres
variables

Affiche/masque la fenêtre Listes de paramètres variables.
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Disposer et regrouper les zones

Vous pouvez détacher et repositionner les différentes zones par glisser-déposer : si vous faites glisser une fenêtre détachée
vers le bord de DriveControlSuite, vous pouvez la relâcher dans une zone mise en surbrillance, à côté ou au-dessus d'une
autre fenêtre, pour l'ancrer à nouveau.

Lorsque vous relâchez la fenêtre sur une autre fenêtre, les deux zones sont fusionnées en une seule fenêtre et vous pouvez
passer d'une zone à l'autre à l'aide d'onglets.

7.1.1.2 Navigation via les schémas des connexions sensibles

Fig. 3: DriveControlSuite : navigation via les liens textuels et les symboles

Pour vous illustrer graphiquement les ordres de traitement des valeurs de consigne et réelles, l'utilisation de signaux ou
certaines dispositions de composants d'entraînement et vous faciliter la configuration des paramètres correspondants, ils
s'affichent sur les pages d'assistant correspondantes de la zone de travail sous forme de schémas des connexions.

Les liens textuels colorés en bleu ou les symboles cliquables désignent les liens internes au programme. Ils renvoient aux
pages d'assistants correspondantes et sont ainsi utiles pour l'accès en un clic aux pages détaillées.
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7.1.2 Interface programme TwinCAT 3
Procédez à la mise en service de votre système EtherCAT dans TwinCAT 3 via TwinCAT System Manager. Le graphique ci-
dessous contient les éléments d'interface importants pour la présente documentation.

3

4

58

21

6

7

Fig. 4: TwinCAT 3 (TwinCAT XAE) : interface programme

N° Zone Description

1 Barre de menus La barre de menus affiche les menus réglés par défaut. Les menus spécifiques à l'éditeur
n'apparaissent que si l'éditeur correspondant est ouvert. Le menu Outils permet de
configurer l'interface utilisateur et, par exemple, de compléter les menus existants ou d'en
définir de nouveaux.

2 Barre d'outils La barre d'outils vous permet d'accéder rapidement aux fonctions les plus fréquemment
utilisées, telles que l'ouverture et l'enregistrement de projets.

3 Solution Explorer Le Solution Explorer reproduit la structure de votre projet avec les éléments de projet qu'il
contient. Sélectionnez d'abord un élément via le Solution Explorer pour l'éditer dans la
fenêtre principale.

4 Fenêtre principale
(éditeur)

Dans la fenêtre principale, vous pouvez définir et éditer des objets, par exemple des
éléments de programmation graphique.

5 Fenêtre de messages La fenêtre de messages vous informe des erreurs ou des avertissements actuels. Par
ailleurs, vous recevrez des messages concernant la vérification de la syntaxe, le processus
de compilation, etc.

6 Fenêtre de propriétés La fenêtre de propriétés affiche les propriétés de l'élément sélectionné dans le Solution
Explorer.

7 Toolbox Affiche les « outils » disponibles pour l'éditeur actif, par exemple les éléments de
programmation graphiques.

8 Barre d'information et
d'état

La barre d'information et d'état vous informe sur l'état du système (mode Config, Run,
Stop ou Exception). En mode en ligne, vous voyez l'état actuel du programme. Si une
fenêtre de l'éditeur est active, la position actuelle du curseur et le mode d'édition réglé
sont en outre affichés.
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7.2 Signification des paramètres
Personnalisez les fonctions du servo-variateur à l'aide des paramètres. Les paramètres visualisent par ailleurs les valeurs
réelles actuelles (vitesse réelle, couple réel...) et déclenchent des actions comme Sauvegarder valeurs, Test de phase etc.

Mode de lecture identifiant de paramètre

Un identifiant de paramètre est composé des éléments suivants, les formes abrégées, c.-à-d. uniquement la saisie d’une
coordonnée ou la combinaison d’une coordonnée et d’un nom, étant possibles.

E50 V0

Coordonnées Nom Version

Servo-variateur G6

Génération/gamme de
servo-variateurs

7.2.1 Groupes de paramètres
Les paramètres sont affectés à différents groupes selon des thèmes. Les servo-variateurs distinguent les groupes de
paramètres suivants.

Groupe Thème

A Servo-variateur, communication, temps de cycle

B Moteur

C Machine, vitesse, couple/force, comparateurs

D Valeur de consigne

E Affichage

F Bornes, entrées et sorties analogiques et numériques, frein

G Technologie – 1re partie (en fonction de l'application)

H Encodeur

I Motion (tous les réglages de mouvement)

J Blocs de déplacement

K Panneau de commande

L Technologie – 2e partie (en fonction de l'application)

M Profils (en fonction de l'application)

N Fonctions additionnelles (en fonction de l'application ; p. ex. boîte à cames étendue)

P Paramètres personnalisés (programmation)

Q Paramètres personnalisés, en fonction de l'instance (programmation)

R Données de fabrication du servo-variateur, du moteur, des freins, de l'adaptateur moteur, du réducteur
et du motoréducteur

S Safety (technique de sécurité)

T Scope

U Fonctions de protection

Z Compteur de dérangements

Tab. 3: Groupes de paramètres
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7.2.2 Genres de paramètres et types de données
Outre le classement par thèmes dans différents groupes, tous les paramètres correspondent à un type de données et à un
type de paramètres précis. Le type de données d'un paramètre s'affiche dans la liste de paramètres, tableau Propriétés. Les
liens qui existent entre les types de paramètres, les types de données et leur plage de valeurs sont indiqués dans le tableau
ci-dessous.

Type de données Type de paramètres Longueur Plage de valeurs (décimales)

INT8 Entier ou sélection 1 octet (avec signe) -128 – 127

INT16 Entier 2 octets (1 mot, avec signe) -32768 – 32767

INT32 Entier ou position 4 octets (1 double-mot, avec
signe)

-2 147 483 648 –
2 147 483 647

BOOL Nombre binaire 1 bit (interne : 
LSB en 1 octet)

0, 1

OCTET Nombre binaire 1 octet (sans signe) 0 – 255

WORD Nombre binaire 2 octets (1 mot, sans signe) 0 – 65535

DWORD Nombre binaire ou adresse
de paramètre

4 octets (1 double-mot, sans
signe)

0 – 4 294 967 295

REAL32
(type single conformément à
IEE754)

Nombre à virgule flottante 4 octets (1 double-mot, avec
signe)

-3,40282 × 1038 – 3,40282 ×
1038

STR8 Texte 8 caractères —

STR16 Texte 16 caractères —

STR80 Texte 80 caractères —

Tab. 4: Paramètres : types de données, types de paramètres, valeurs possibles

Types de paramètres : utilisation

§ Entier, nombre à virgule flottante
Dans le cas de processus de calcul généraux
Exemple : valeurs de consigne et valeurs réelles

§ Sélection
Valeur numérique à laquelle est affectée une signification directe
Exemple : sources de signaux ou de valeurs de consigne

§ Nombre binaire
Informations sur les paramètres orientées bit et regroupées sous forme binaire
Exemple : mots de commande et mots d'état

§ Position
Entier en combinaison avec les unités correspondantes et les décimales
Exemple : valeurs réelles et de valeurs consigne de positions

§ Vitesse, accélération, décélération, à-coup
Nombre à virgule flottante en relation avec les unités associées
Exemple : valeurs réelles et valeurs de consigne pour vitesse, accélération, décélération, à-coups

§ Adresse de paramètre
Référençage d'un paramètre
Exemple : dans la AO1 source F40, la n-Moteur filtré E08 peut p. ex. être paramétrée

§ Texte
Sorties ou messages
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7.2.3 Types de paramètres
On distingue les types de paramètres suivants.

Type de paramètre Description Exemple

Paramètres simples Se composent d'un groupe et d'une ligne
avec une valeur fixe définie.

A21 Résistance de freinage R : valeur =
100 ohms

Paramètres Array Se composent d'un groupe, d'une ligne et de
plusieurs éléments (listés) continus
possédant les mêmes propriétés mais
toutefois des valeurs différentes.

A10 Niveau d'accès

§ A10[0] Niveau d'accès : valeur = niveau
d'accès via l'unité de commande

§ A10[2] Niveau d'accès : valeur = niveau
d'accès via CANopen et EtherCAT

§ A10[4] Niveau d'accès : valeur = niveau
d'accès via PROFINET

Paramètres Record Se composent d'un groupe, d'une ligne et de
plusieurs éléments (listés) continus
possédant des propriétés différentes et des
valeurs différentes.

A00 Sauvegarder valeurs

§ A00[0] Démarrer : valeur = démarrer
l'action

§ A00[1] Progression : valeur = afficher la
progression de l'action

§ A00[2] Résultat : valeur = afficher le
résultat de l'action

Tab. 5: Types de paramètres

7.2.4 Structure des paramètres
Chaque paramètre possède des coordonnées spécifiques qui correspondent à la structure ci-après.

E250 [2] .3

Axe
Groupe

Ligne

1.

Élément
Bit

§ Axe (en option)
Dans le cas de plusieurs axes, celui auquel un paramètre est affecté ; sans objet pour les paramètres globaux (plage de
valeurs : 1 - 4).

§ Groupe
Groupe auquel un paramètre appartient thématiquement (plage de valeurs : A - Z).

§ Ligne
Distingue les paramètres à l'intérieur d'un groupe de paramètres (plage de valeurs : 0 – 999).

§ Élément (en option)
Éléments d'un paramètre Array ou Record (plage de valeurs : 0 - 16000).

§ Bit (en option)
Sélection d'un seul bit pour l'adressage complet des données ; dépend du type de données (plage de valeurs : 0 – 31).
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7.2.5 Visibilité des paramètres
La visibilité d'un paramètre est principalement contrôlée par le niveau d'accès que vous définissez dans DriveControlSuite
ainsi que par les propriétés que vous planifiez pour le servo-variateur concerné (p. ex. matériel, micrologiciel et
application). Un paramètre peut, en outre, être affiché ou masqué en fonction d'autres paramètres ou réglages : par
exemple, les paramètres d'une fonction additionnelle ne s'affichent que lorsque vous activez la fonction additionnelle en
question.

Niveau d'accès

Les possibilités d'accès aux différents paramètres du logiciel sont hiérarchisées et divisées en différents niveaux. Cela
signifie qu'il est possible de masquer spécifiquement des paramètres et ainsi de verrouiller leurs possibilités de
configuration à partir d'un certain niveau.

Chaque paramètre possède un niveau d'accès pour l'accès en lecture seule (visibilité) et un niveau d'accès pour l'accès en
écriture seule (éditabilité). On distingue les niveaux suivants :

§ Niveau 0
Paramètres élémentaires

§ Niveau 1
Paramètres essentiels d'une application

§ Niveau 2
Paramètres essentiels pour la maintenance avec de nombreuses possibilités de diagnostic

§ Niveau 3
Tous les paramètres nécessaires pour la mise en service et l'optimisation d'une application

Le paramètre A10 Niveau d'accès règle l'accès général aux paramètres :

§ Via CANopen ou EtherCAT (A10[2])

§ Via PROFINET (A10[3])

Information

Il est impossible de lire ou d'écrire les paramètres masqués dans DriveControlSuite lors de la communication via le bus de
terrain.

Matériel

Les paramètres dont vous disposez dans DriveControlSuite sont p. ex. déterminés par la gamme que vous sélectionnez dans
la boîte de dialogue de planification du servo-variateur, ou par l'option ou non de planification d'un module optionnel. En
général, seuls les paramètres dont vous avez besoin pour le paramétrage du matériel configuré s'affichent.

Micrologiciel

Grâce au perfectionnement et à la maintenance des fonctions des servo-variateurs, de nouveaux paramètres ainsi que de
nouvelles versions des paramètres existants sont sans cesse implémentés dans DriveControlSuite et dans le micrologiciel.
Les paramètres vous sont indiqués dans le logiciel en fonction de la version DriveControlSuite utilisée et de la version de
micrologiciel planifié du servo-variateur concerné.

Applications

Les applications se distinguent en règle générale par leurs fonctions et leur commande. Par conséquent, chaque application
offre des paramètres différents.
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7.3 Sources de signaux et mappage des données process
La transmission de signaux de commande et de valeurs de consigne dans DriveControlSuite satisfait aux principes suivants.

Sources de signaux

Les servo-variateurs sont commandés soit via un bus de terrain, en mode mixte avec système de bus de terrain et bornes
ou exclusivement via des bornes. 
L'option de récupération des signaux de commande et des valeurs de consigne de l'application via un bus de terrain ou via
des bornes peut être configurée à l'aide des paramètres de sélection correspondants désignés comme sources de signaux.

Dans le cas d'une commande via le bus de terrain, les paramètres sont sélectionnés comme sources pour les signaux de
commande ou les valeurs de consigne qui doivent faire partie du mappage des données process suivant ; dans le cas d'une
commande via des bornes, les entrées analogiques ou numériques correspondantes sont indiquées directement.

Mappage des données process

Si vous utilisez un système de bus de terrain et si vous avez sélectionné les paramètres source pour les signaux de
commande et les valeurs de consigne, configurez pour finir les réglages spécifiques au bus de terrain, p. ex. l'affectation des
canaux de données process pour la transmission des données process de réception et d'émission. Pour la démarche à suivre
dans chaque cas, consultez les manuels correspondants sur les bus de terrain.

7.4 Enregistrement dans une mémoire non volatile
Toutes les planifications, tous les paramétrages ainsi que les modifications des valeurs de paramètres associées prennent
effet après la transmission au servo-variateur, mais ne sont enregistrés que dans une mémoire volatile.

Enregistrement sur un servo-variateur

Pour enregistrer la configuration de manière non volatile sur un servo-variateur, vous avez les possibilités suivantes :

§ Enregistrer la configuration via l'assistant Sauvegarder valeurs :
Menu de projet > Zone Assistants > Axe planifié > Assistant Sauvegarder valeurs : sélectionnez l'action Sauvegarder
valeurs

§ Enregistrer la configuration via la liste de paramètres :
Menu de projet > Zone Liste de paramètres > Axe planifié > Groupe A : servo-variateurs > A00 Sauvegarder valeurs :
réglez le paramètre A00[0] sur la valeur 1: Actif

§ Enregistrer la configuration à l'aide de la touche S1 :
servo-variateur avec touche S1 : maintenez la touche enfoncée pendant 3 s

Enregistrement sur tous les servo-variateurs dans le cadre d'un projet

Pour enregistrer la configuration de manière non volatile sur plusieurs servo-variateurs, vous avez les possibilités suivantes :

§ Enregistrer la configuration via la barre d'outils :
Barre d'outils > Icône Enregistrer les valeurs : cliquez sur l'icône Enregistrer les valeurs

§ Enregistrer la configuration dans la fenêtre Fonctions en ligne :
Menu de projet > Bouton Liaison en ligne > Fenêtre Fonctions en ligne : cliquez sur Enregistrer les valeurs (A00)

Information

Ne mettez pas le servo-variateur hors tension pendant l'enregistrement. Si la tension d'alimentation de la pièce de
commande est interrompue pendant l'enregistrement, le servo-variateur démarre à la prochaine mise sous tension avec le
dérangement 40 : Données invalides. Pour mener à bien le processus d'enregistrement, la configuration doit être à nouveau
enregistrée de manière non volatile.
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8 Mise en service
Les chapitres suivants décrivent la mise en service de votre servo-variateur avec module de sécurité SY6 intégré à l'aide de
DriveControlSuite et du configurateur TwinSAFE de TwinCAT 3 de la société Beckhoff Automation GmbH & Co. KG.

Pour un suivi exact des différentes étapes de la mise en service, nous citons en exemple l'environnement système suivant
comme condition préalable :

§ Servo-variateurs de la gamme SC6 ou SI6 à partir de la version de micrologiciel V 6.4-D-EC avec module de sécurité SY6
intégré

§ Logiciel de mise en service DriveControlSuite à partir de V 6.4-D

en combinaison avec

§ Beckhoff CX2030 – module de base CPU (commande, MainDevice EtherCAT)

§ Borne TwinSAFE-Logic EL6900 Beckhoff (commande de sécurité, MainInstance FSoE)

§ Coupleur de bus Beckhoff EK1100 (coupleur de bus EtherCAT)

§ Borne d'entrée numérique à 4 canaux TwinSAFE EL1904 Beckhoff (borne numérique avec 4 entrées à sécurité intégrée)

§ Logiciel d'automatisation TwinCAT 3 Beckhoff : TwinCAT System Manager (configurateur TwinSAFE), TwinCAT XAE

La mise en service comporte les étapes suivantes ...

1. Module de sécurité SY6
Attribuez une adresse FSoE valide via les commutateurs DIP.

2. Observez les recommandations relatives aux réglages de l'heure valables pour la configuration ci-après.

3. DriveControlSuite
Configurez tous les servo-variateurs, y compris le module de sécurité, la commande de l'appareil, les données process
pour la communication par bus de terrain ainsi que les axes de votre système d'entraînement dans DriveControlSuite.
Générez un fichier ESI et transférez ensuite votre configuration de projet vers les servo-variateurs du réseau système
intégré.

4. TwinCAT 3
Mettez à disposition le fichier ESI TwinCAT 3 généré. Reproduisez ensuite votre environnement matériel complet et
configurez-le. Mettez ensuite votre système en service et vérifiez la communication TwinSAFE des participants au
système.

8.1 SY6 : attribuer l'adresse FSoE
Afin de pouvoir identifier de manière univoque le module de sécurité SY6 dans le réseau FSoE, vous devez lui affecter une
adresse univoque dans le réseau FSoE. L'adresse résulte des valeurs des commutateurs DIP situés dans la partie supérieure
du servo-variateur et placés sur ON. Pour de plus amples informations à ce sujet, voir SY6 : attribuer une adresse FSoE
[} 59]).

Information

Le servo-variateur doit être hors tension avant l'attribution de l'adresse du module de sécurité SY6 via les commutateurs
DIP S12. L'adresse est appliquée uniquement après un redémarrage du servo-variateur.
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8.2 Réglages de l'heure recommandés
Dans le cas d'un arrêt rapide suivi d'une STO (catégorie d'arrêt 1 conformément à DIN EN 60204-1 ou Safe Stop 1 (SS1-t)
conformément à DIN EN 61800-5-2) ou d'une interruption de la communication lors de la mise à l'arrêt commandée de
l'axe, il existe un risque d'arrêt prématuré du bloc de puissance. Dans ce cas, le mouvement de l'axe ne peut plus être
commandé par le servo-variateur.

Afin d'empêcher l'arrêt prématuré du bloc de puissance, vous devez tenir compte de la temporisation lors de l'arrêt rapide
(temps d'arrêt rapide) pendant le paramétrage de la temporisation SS1.

Temps d'arrêt rapide

Le temps d'arrêt rapide est calculé à partir de la décélération d'arrêt rapide spécifique à l'application et de la vitesse
maximale. Dans le cas de l'application CiA 402, paramétrez la décélération d'arrêt rapide dans A578 Arrêt rapide
décélération, pour les applications de type Drive Based dans I17 Décélération de l'arrêt rapide. Paramétrez la vitesse
maximale dans I10 Vitesse maximale.

Temporisation SS1

Pour T_SS1 dans le MainInstance FSoE, définissez une valeur supérieure à celle du temps d'arrêt rapide en résultant. En
règle générale, la réserve devrait être de 10 % et ne devrait pas être inférieure à 50 ms. Vous pouvez vérifier la
temporisation SS1 dans S593 SS1 temps jusqu'à STO.

Temps du chien de garde FSoE

Réglez une valeur suffisamment grande pour le temps du chien de garde dans TwinCAT 3 afin d'éviter des déclenchements
intempestifs (p. ex. en raison d'un temps de cycle trop lent) ou le dérangement 70 : Consistance des paramètres avec la
cause 15.

Observez la condition suivante :

S27 Safety durée du chien de garde > A258 EtherCAT PDO-Timeout + S26 FSoE temps de cycle + 26 ms

Dans TwinCAT 3, un temps du chien de garde global de 100 ms est réglé par défaut.

Pour plus d'informations sur le temps du chien de garde, voir Temps du chien de garde [} 60].
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8.3 DS6 : configurer le servo-variateur
Planifiez et configurez tous les servo-variateurs de votre système d'entraînement via DriveControlSuite.

8.3.1 Créer un projet
Afin de pouvoir configurer tous les servo-variateurs et axes de votre système d'entraînement à l'aide du DriveControlSuite,
vous devez les saisir dans le cadre d'un projet.

8.3.1.1 Planifier le servo-variateur et l'axe

Créez un nouveau projet et planifiez le premier servo-variateur et l'axe correspondant.

Information

Assurez-vous de planifier la bonne gamme dans l'onglet Servo-variateur. La gamme planifiée ne pourra plus être modifiée.

Créer un nouveau projet

1. Démarrez le DriveControlSuite.

2. Cliquez sur Créer un nouveau projet sur l'écran d'accueil.

ð Le nouveau projet est créé et la boîte de dialogue de planification s'ouvre pour le premier servo-variateur.

ð Le bouton Servo-variateur est actif.

Planifier un servo-variateur

1. Onglet Propriétés : 
établissez dans DriveControlSuite la relation entre votre schéma de connexion et le servo-variateur à planifier.

1.1. Référence :
définissez le code de référence (code d'équipement) du servo-variateur.

1.2. Désignation :
dénommez le servo-variateur de manière univoque.

1.3. Version :
attribuez une version à votre planification.

1.4. Description :
mémorisez éventuellement des informations complémentaires utiles (p. ex. historique des modifications).

2. Onglet Servo-variateur :
sélectionnez la gamme, le type de servo-variateur et la variante du micrologiciel du servo-variateur.

2.1. Micrologiciel :
sélectionnez la version EtherCAT V 6.x -EC.

3. Onglet Modules optionnels, Module de sécurité :
sélectionnez le module de sécurité SY6.

4. Onglet Commande de l'appareil :
planifiez la commande de base du servo-variateur.

4.1. Commande de l'appareil :
sélectionnez la commande de l'appareil CiA 402.

4.2. Données process Rx, données process Tx :
si vous commandez le servo-variateur par un bus de terrain, sélectionnez les données process de réception et
d'émission correspondantes.
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4.3. Si vous souhaitez utiliser des produits matériels et logiciels de la société Beckhoff et le service SDO Info,
sélectionnez EtherCAT Rx SDO Info et EtherCAT Tx pour la transmission des données process EtherCAT. La
configuration du SDO Info s'effectue dans TwinCAT 3. Pour de plus amples informations, voir le manuel sur la
communication avec EtherCAT.

PRUDENCE

Modification de l'adressage lors du changement de modèle

Si vous changez le modèle de EtherCAT Rx à EtherCAT Rx SDO Info, l'adressage des éléments des paramètres Array et
Record change également. Faites-y attention en particulier dans les configurations existantes. Différents fichiers ESI sont
créés pour les modèles. Lorsque vous modifiez le modèle, vous devez générer un nouveau fichier ESI en vous servant de
l'assistant dans DriveControlSuite et le mettre à la disposition de TwinCAT 3. Une modification du modèle entraîne une
modification du numéro de révision du servo-variateur (Revision number). Par conséquent, redémarrez le servo-variateur
après la modification du modèle.

Planifier un axe

1. Cliquez sur Axe A.

2. Onglet Propriétés : 
établissez dans DriveControlSuite la relation entre votre schéma de connexion et l'axe à planifier.

2.1. Référence :
définissez le code de référence (code d'équipement) de l'axe.

2.2. Désignation :
dénommez l'axe de manière univoque.

2.3. Version :
attribuez une version à votre planification.

2.4. Description :
mémorisez éventuellement des informations complémentaires utiles (p. ex. historique des modifications).

3. Onglet Application :
sélectionnez l'application CiA 402 (version incrémentielle).

4. Onglet Moteur :
sélectionnez le type de moteur que vous exploitez via cet axe. Si vous utilisez des moteurs de fabricants tiers, entrez
ultérieurement les données moteur correspondantes.

5. Répétez les étapes pour l'axe B (seulement dans le cas de régulateurs double axe).

6. Cliquez sur OK pour confirmer.
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8.3.2 Paramétrer les réglages EtherCAT généraux

ü Dans le cadre de la planification du servo-variateur et de l'axe, vous avez planifié, entre autres, le module de sécurité
SY6 ainsi qu'une commande de l'appareil avec les données process.

1. Dans l'arborescence de projet, marquez le servo-variateur concerné et cliquez dans le menu de projet > Zone Assistant
sur l'axe planifié souhaité.

2. Sélectionnez l'assistant EtherCAT.

3. A213 Mise à l'échelle bus de terrain :
laissez le réglage par défaut sur 1: Valeur brute (les valeurs sont transférées telles quelles).

4. A258 EtherCAT PDO-Timeout :
pour pouvoir détecter une panne de communication, surveillez l'entrée des données process cycliques via la définition
d'une temporisation PDO. 
Plage de valeurs admissible : 0 – 65535 ms. 
Remarque :
0 et 65535 = surveillance inactive 
1 à 65531 = surveillance active 
65532 = surveillance active, toutefois la défaillance d'un paquet de données est ignorée
65533 = surveillance active, toutefois la défaillance conséquente de trois paquets de données est ignorée

5. En option : si vous souhaitez utiliser le service SDO Info, définissez via A268 les objets pouvant être lus par la
commande via SDO Info.
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8.3.3 Configurer la transmission PDO
Les canaux PDO servent à la transmission en temps réel des informations de commande et d'état ainsi que des valeurs
réelles et de consigne d'un MainDevice EtherCAT aux SubDevices EtherCAT et vice-versa.

La communication PDO permet le fonctionnement simultané de plusieurs canaux PDO pour chaque sens de transmission et
de réception. Les canaux pour les axes A et B comportent chacun un PDO avec au maximum 24 paramètres à transférer
dans un ordre défini. Ces derniers peuvent être configurés librement. Un canal est réservé pour la communication FSoE et
est automatiquement paramétré.

Afin de garantir une communication impeccable entre la commande et le servo-variateur, STOBER propose une affectation
par défaut, dépendante de l'application des canaux et pouvant être modifiée à tout moment.

8.3.3.1 Personnaliser RxPDO

ü Vous avez configuré les réglages EtherCAT globaux.

1. Dans l'arborescence de projet, marquez le servo-variateur concerné et cliquez dans le menu de projet > Zone Assistant
sur l'axe planifié souhaité.

2. Sélectionnez l'assistant EtherCAT > Données process de réception RxPDO.

3. Vérifiez les préréglages et/ou configurez les données process conformément à vos exigences.
A225[0] – A225[23], A226[0] – A226[23] :
paramètres dont les valeurs sont reçues par chacun des servo-variateurs depuis la commande. La position des
paramètres fournit des informations sur l'ordre de réception correspondant.

8.3.3.2 Personnaliser TxPDO

ü Vous avez configuré les réglages EtherCAT globaux.

1. Dans l'arborescence de projet, marquez le servo-variateur concerné et cliquez dans le menu de projet > Zone Assistant
sur l'axe planifié souhaité.

2. Sélectionnez l'assistant EtherCAT > Données process d'émission TxPDO.

3. Vérifiez les préréglages et/ou configurez les données process conformément à vos exigences.
A233[0] – A233[23], A234[0] – A234[23] : 
paramètres dont les valeurs sont envoyées par le servo-variateur concerné vers la commande. La position des
paramètres fournit des informations sur l'ordre d'envoi correspondant.
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8.3.4 Transférer et enregistrer la configuration
Pour transférer la configuration vers un ou plusieurs servo-variateurs et l'enregistrer, vous devez connecter votre
ordinateur personnel aux servo-variateurs via le réseau.

AVERTISSEMENT !

Dommages corporels et matériels dus au mouvement de l'axe !

Si une connexion en ligne entre DriveControlSuite et le servo-variateur existe, des modifications de la configuration peuvent
entraîner des mouvements de l'axe inattendus.

▪ Ne modifiez la configuration que si vous avez un contact visuel avec l'axe.

▪ Assurez-vous qu'aucune personne et qu'aucun objet ne se trouve dans la plage de déplacement.

▪ Pour l'accès par télémaintenance, un lien de communication entre vous et une personne sur place avec un contact
visuel avec l'axe doit être établi.

Information

Lors de la recherche, tous les servo-variateurs à l'intérieur du domaine de diffusion sont localisés via la diffusion IPv4-
Limited.

Conditions préalables à la localisation d'un servo-variateur dans le réseau :

▪ Le réseau prend en charge la diffusion IPv4-Limited

▪ Tous les servo-variateurs et l'ordinateur personnel sont dans le même sous-réseau (domaine de diffusion)

ü Les servo-variateurs sont en marche et sont trouvables dans le réseau.

1. Dans l'arborescence de projet, marquez le module sous lequel vous avez saisi votre servo-variateur et cliquez dans le
menu de projet sur Liaison en ligne.

ð La boîte de dialogue Ajouter une liaison s'ouvre. Tous les servo-variateurs détectés via la diffusion IPv4-Limited
s'affichent.

2. Onglet Liaison directe, colonne Adresse IP : 
activez les adresses IP concernées et cliquez sur OK pour confirmer votre sélection.

ð La fenêtre Fonctions en ligne s'ouvre. Tous les servo-variateurs connectés via les adresses IP sélectionnées
s'affichent.

3. Sélectionnez le module et le servo-variateur vers lequel vous souhaitez transférer une configuration. Modifiez la
sélection du mode de transfert de Lire à Envoyer.

4. Modifiez la sélection Créer un nouveau servo-variateur :
sélectionnez la configuration que vous souhaitez transférer vers le servo-variateur.

5. Répétez les étapes 3 et 4 pour tous les autres servo-variateurs vers lesquels vous souhaitez transférer une
configuration.

6. Onglet En ligne :
cliquez sur Établir des liaisons en ligne.

ð Les configurations sont transférées vers les servo-variateurs.
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Enregistrer la configuration

ü Vous avez transféré la configuration avec succès.

1. Fenêtre Fonctions en ligne, onglet En ligne, zone Actions pour les servo-variateurs en mode en ligne :
cliquez sur Enregistrer les valeurs (A00).

ð La fenêtre Enregistrer les valeurs (A00) s'ouvre.

2. Sélectionnez les servo-variateurs sur lesquels vous souhaitez enregistrer la configuration.

3. Cliquez sur Démarrer l'action.

ð La configuration est enregistrée de manière non volatile sur les servo-variateurs.

4. Fermez la fenêtre Enregistrer les valeurs (A00).

Information

Pour que la configuration prenne effet sur le servo-variateur, un redémarrage est nécessaire, par exemple après le premier
enregistrement de la configuration sur le servo-variateur ou en cas de modifications du micrologiciel ou du mappage des
données process.

Redémarrer le servo-variateur

ü Vous avez enregistré la configuration de manière non volatile sur le servo-variateur.

1. Fenêtre Fonctions en ligne, onglet En ligne :
cliquez sur Redémarrer (A09).

ð La fenêtre Redémarrer (A09) s'ouvre.

2. Sélectionnez les servo-variateurs connectés que vous souhaitez redémarrer.

3. Cliquez sur Démarrer l'action.

4. Cliquez sur OK pour confirmer la consigne de sécurité.

ð La fenêtre Redémarrer (A09) se ferme.

ð La communication par bus de terrain et la liaison entre DriveControlSuite et les servo-variateurs sont interrompues.

ð Les servo-variateurs sélectionnés redémarrent.
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8.3.5 Créer un fichier ESI
Les fonctions et les propriétés des servo-variateurs STOBER sont décrites sous forme de différents objets et résumées dans
un fichier ESI.

Étant donné que vous utilisez TwinCAT 3, la génération d'un fichier ESI est obligatoire. Le fichier doit être mis à disposition
par TwinCAT 3 dans le répertoire indiqué ci-dessous. Notez que TwinCAT 3 peut charger uniquement un fichier ESI par
gamme de servo-variateur.

Si vous utilisez différentes applications ou différentes configurations de transmission PDO, vous devez étendre votre fichier
ESI avec les modules correspondants. Pour plus d'informations sur les fichiers ESI modulaires, veuillez consulter le manuel
EtherCAT.

À chaque modification de la transmission PDO ou du modèle de configuration, un nouveau fichier ESI doit être généré et
mis à disposition de TwinCAT 3.

ü Vous êtes actuellement dans DriveControlSuite et avez terminé la configuration de la transmission PDO.

1. Dans l'arborescence de projet, marquez le servo-variateur concerné et cliquez dans le menu de projet > Zone Assistant
sur l'axe planifié souhaité.

2. Sélectionnez l'assistant EtherCAT.

3. Cliquez sur Créer un ESI.

ð La boîte de dialogue Fichier ESI en cours d'écriture s'ouvre.

4. Enregistrez le fichier XML dans le répertoire à partir duquel la commande le charge (installation standard TwinCAT 3 :
C:\TwinCAT\3.1\Config\IO\EtherCAT).

ð Le fichier ESI est chargé au prochain démarrage de TwinCAT 3.
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8.4 TwinCAT 3 : configurer la technique de sécurité
TwinCAT 3 offre la possibilité de reproduire votre environnement matériel via TwinCAT XAE. 
Vous paramétrez automatiquement tous les paramètres de bus nécessaires dans le logiciel par numérisation matérielle.
Configurez ensuite un programme de sécurité individuel qui commande les signaux d'exigence de sécurité STO et SS1. 
Des blocs fonctionnels prédéfinis que vous reliez aux entrées et sorties souhaitées sont disponibles à cet effet. La
configuration d'un programme de sécurité est décrite ci-dessous à l'exemple du bloc fonctionnel safeEstop (Emergency
Stop).
Transférez enfin le programme de sécurité prêt vers le MainInstance FSoE.

Notez que tous les participants au système FSoE doivent être clairement identifiables par une adresse FSoE- individuelle
(réglage par les commutateurs DIP) dans le réseau EtherCAT. Attribuez les adresses FSoE avant le montage et
l'interconnexion des différents appareils et bornes.

Information

Exécutez impérativement les étapes mentionnées ci-après dans l'ordre indiqué !

Certains paramètres sont dépendants les uns des autres et ne sont accessibles que si vous avez procédé auparavant à
certains réglages. Suivez les étapes dans l'ordre prescrit afin de pouvoir finaliser intégralement le paramétrage.

8.4.1 Activer le MainDevice EtherCAT

ü Vous avez planifié au préalable tous les servo-variateurs de votre système via DriveControlSuite et transféré la
configuration vers les différents servo-variateurs. Le MainDevice EtherCAT est raccordé au réseau, tous les
composants de sécurité possèdent une adresse FSoE, sont sous tension et l'infrastructure est opérationnelle. Vous
avez enregistré le fichier ESI généré dans le répertoire indiqué. Les fichiers ESI des appareils Beckhoff sont déjà
mémorisés dans le système TwinCAT.

1. Démarrez TwinCAT XAE.

ð Le fichier ESI mémorisé est chargé au démarrage du programme et la fenêtre principale s'ouvre. L'onglet Start
Page est actif.

2. Sélectionnez File > New > Project....

ð La fenêtre New Project s'ouvre.

3. Sélectionnez Installed > Templates > TwinCAT Projects > TwinCAT XAE Project (XML format).

4. Name, Location, Solution name : 
nommez le projet, indiquez un emplacement d'enregistrement et un nom de projet interne.

5. Fermez la fenêtre.

6. Poursuivez selon le type d'installation :

6.1. Si Run-Time (MainDevice EtherCAT) et TwinCAT XAE ont été installés sur un ordinateur personnel, ils sont
automatiquement interconnectés.
Continuez avec l'étape 16.

6.2. Si Run-Time (MainDevice EtherCAT) et TwinCAT System Manager ont été installés sur différents ordinateurs
personnels, vous devez les interconnecter.
Si un routage vers la commande a déjà été créé, passez à l'étape 15.
Si vous souhaitez connecter un nouvel appareil, suivez toutes les étapes ci-dessous.

7. Dans la barre d'outils TwinCAT XAE, cliquez sur la zone de liste <Local> et sélectionnez Choose Target System....

ð La fenêtre Choose Target System s'ouvre.

8. Cliquez sur Search (Ethernet)....

ð La fenêtre Add Route Dialog s'ouvre.



8 | Mise en service STOBER

36

08
/2

02
4 

| 
ID

 4
42

74
5.

04

9. Cliquez sur Broadcast Search.

ð La fenêtre Select Adapter(s) s'ouvre.

10. Marquez l'adaptateur relié à votre commande et cliquez sur OK pour confirmer.

ð Toutes les commandes disponibles sont alors affichées dans une liste.

11. Marquez la commande souhaitée et cliquez sur Add Route pour confirmer.

ð La fenêtre Add Remote Route s'ouvre.

12. Sous Remote User Credentials, entrez les données suivantes :
User name: Administrator
Password : 1

13. Cliquez sur OK pour confirmer.

14. Fermez les fenêtres Add Route Dialog et Choose Target System.

15. Dans la barre d'outils TwinCAT XAE, cliquez sur la zone de liste <Local> et sélectionnez dans la liste déroulante la
commande ajoutée.

ð Le MainDevice EtherCAT est enregistré comme système cible.

16. Pour pouvoir configurer le système EtherCAT en ligne, vous devez activer le mode de configuration (Config Mode) du
logiciel TwinCAT XAE.
Sélectionnez le menu TWINCAT > Restart TwinCAT (Config Mode).

ð La boîte de dialogue Restart TwinCAT System in Config Mode s'ouvre.

17. Cliquez sur OK pour confirmer.

ð Le MainDevice EtherCAT est enregistré comme système cible, TwinCAT XAE est en mode Config.
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8.4.2 Numériser l'environnement matériel
Si tous les composants système sont raccordés au réseau EtherCAT et si ce dernier est sous tension, il est possible
d'effectuer une numérisation automatique selon les participants au système. Dans ce cas, TwinCAT XAE cherche les
appareils et bornes connectés et les intègre dans le projet existant conformément à leurs entrées dans les fichiers ESI
correspondants.

Si la véritable infrastructure EtherCAT n'est pas disponible, c.-à-d. si vous effectuez la configuration en mode hors ligne,
vous devez reproduire et planifier manuellement tous les participants au système dans TwinCAT XAE. Vous trouverez de
plus amples informations à ce sujet dans l'aide en ligne du logiciel TwinCAT XAE.

ü Vous avez activé le mode Config.

1. Dans Solution Explorer, naviguez vers I/O > Devices > Menu contextuel Scan.

2. Confirmez la boîte de dialogue HINT: Not all types of devices can be found automatically en cliquant sur OK.

ð TwinCAT XAE analyse le système EtherCAT à la recherche du MainDevice EtherCAT.

ð La boîte de dialogue ... new I/O devices found s'ouvre.

3. Activez le MainDevice EtherCAT concerné et confirmez avec OK.

ð Le MainDevice EtherCAT est créé dans Solution Explorer sous I/O > Devices comme Device (EtherCAT).

ð La boîte de dialogue Scan for boxes? s'ouvre.

4. Confirmez avec Yes.

ð TwinCAT XAE analyse le système EtherCAT à la recherche des SubDevices EtherCAT.

ð La boîte de dialogue EtherCAT drive(s) added s'ouvre.

5.  Append linked axis to :
si vous avez besoin d'une fonctionnalité NC ou CNC, activez l'option souhaitée et confirmez avec OK.

ð Dans Solution Explorer, les coupleurs de bus des SubDevices EtherCAT (borne EK1100) avec le MainInstance FSoE
(borne EL6900) et les entrées sûres (bornes EL1904) ainsi que le servo-variateur sont créés. 
La boîte de dialogue Activate Free Run s'ouvre.

6. Afin de mettre les composants système durant leur configuration dans un mode de marche libre (Free Run) et de
pouvoir ainsi vérifier l'échange de signaux, confirmez avec Yes.

ð Le MainDevice et les SubDevices EtherCAT sont créés dans TwinCAT XAE.
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8.4.3 Configurer le projet TwinCAT SAFETY
Un TwinCAT SAFETY est composé d'un groupe TwinSAFE avec des Alias Devices, c.-à.d. les composants matériels de votre
système, ainsi que l'élément SAFETY même avec tous les blocs fonctionnels correspondants qui représentent la logique de
sécurité. Les blocs fonctionnels possèdent des paramètres qui doivent être configurés de manière spécifique à l'application.

Dans la première étape créez un projet SAFETY avec tous les Alias Devices et configurez ensuite, par exemple, le bloc
fonctionnel safeEstop.

8.4.3.1 Créer un projet TwinCAT SAFETY

1. Naviguez dans Solution Explorer vers SAFETY > Menu contextuel Add New Item.

ð La boîte de dialogue Add New Item s'ouvre.

2. Marquez l'entrée TwinCAT Safety Project Preconfigured ErrAc.

3. Name : 
nommez le projet SAFETY et confirmez avec Add.

ð La boîte de dialogue TwinCAT Safety Project Wizard s'ouvre.

4. Internal Project Name : 
si nécessaire, attribuez un nom de projet interne au système et confirmez avec OK.

ð Dans Solution Explorer le projet SAFETY, un système cible, ainsi qu'un groupe TwinSAFE sont créés sous le nom
que vous avez attribué. Le groupe TwinSAFE comporte déjà un dossier pour les Alias Devices devant encore être
créés ; l'Alias Device ErrorAcknowledgement.sds comme entrée Reset est disponible par défaut.

5. Pour définir le MainInstance FSoE comme système cible, sélectionnez dans Solution Explorer le nouveau projet SAFETY
et double-cliquez sur Target System.

6. Fenêtre principale > Physical Device : 
cliquez sur l'icône correspondante.

ð La boîte de dialogue Choose physical terminal for mapping s'ouvre.

7. Terminal : 
marquez le MainInstance FSoE EL6900 et confirmez en cliquant sur OK.

8. Fenêtre principale > Hardware Address : 
l'adresse FSoE du MainInstance FSoE a été automatiquement chargée vers TwinCAT XAE.

9. Pour enregistrer le projet, sélectionnez le menu FILE > Safe Selected Items.

ð Le projet SAFETY est créé et le MainInstance FSoE est configuré comme système cible correspondant.
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8.4.3.2 Créer des Alias Devices

Le matériel requis pour le projet SAFETY est intégré comme Alias Device correspondant dans le groupe TwinSAFE.

1. Naviguez dans Solution Explorer vers votre projet SAFETY > TwinSafeGroup1 > Alias Devices > Menu contextuel Add >
New Item.

ð La boîte de dialogue Add New Item s'ouvre.

2. Pour créer un Alias-Device comme entrée pour le démarrage du groupe TwinSAFE, sélectionnez  Installed > Standard 
> 1 Digital Input (standard).

3. Name : 
nommez l'Alias-Device avec RUN et confirmez avec Add.

4. Dans Solution Explorer, sélectionnez à nouveau le dossier Alias Devices > Menu contextuel Add > New Item.

5. Pour créer un Alias-Device pour les entrées de sécurité (borne EL1904), sélectionnez  Safety  > EtherCAT > Beckhoff
Automation GmbH > 4 Digital Inputs.

6. Name : 
si nécessaire, nommez le Device et confirmez avec Add.

7. Dans Solution Explorer, sélectionnez à nouveau le dossier Alias Devices > Menu contextuel Add > New Item.

8. Pour créer un Alias-Device pour le servo-variateur avec le module de sécurité SY6 intégré, sélectionnez  Safety  >
EtherCAT > STOEBER ANTRIEBSTECHNIK GmbH & Co. KG > 0xB1EC5956 - Safety (FSoE).

9. Name : 
si nécessaire, nommez le Device et confirmez avec Add.

ð Les composants matériels mentionnés sont créés comme Alias Devices du groupe TwinSAFE dans Solution Explorer.

8.4.3.3 Affecter les Alias Devices et entrer les adresses FSoE

Affectez les Alias Devices créés aux différents composants matériels de votre système et attribuez les adresses FSoE
correspondantes.

1. Dans Solution Explorer, naviguez vers votre projet SAFETY > TwinSafeGroup1 > Alias Devices et double-cliquez sur
ErrorAcknowledgement.sds.

2. Fenêtre principale > Full Name : 
cliquez sur l'icône correspondante.

ð La boîte de dialogue Attach Variable Standard In Var 1 (Output) s'ouvre.

3. Show Variables :
pour afficher tous les appareils, activez l'option Used and unused.

4. Show Variables : 
pour afficher les entrées par défaut, désactivez la case Exclude other Devices.

5. Sélectionnez l'entrée par défaut souhaitée pour la réinitialisation du groupe TwinSAFE et confirmez avec OK.

6. Dans Solution Explorer, sélectionnez le dossier Alias Devices et double-cliquez sur RUN.sds.

7. Fenêtre principale > Full Name : 
cliquez sur l'icône correspondante.

ð La boîte de dialogue Attach Variable Standard In Var 1 (Output) s'ouvre.

8. Sélectionnez l'entrée par défaut souhaitée pour le démarrage du groupe TwinSAFE et confirmez avec OK.

ð Les entrées matérielles par défaut pour la réinitialisation et le démarrage du groupe TwinSAFE-Gruppe sont
connectées aux Alias Devices correspondants.

9. Dans Solution Explorer, sélectionnez le dossier Alias Devices et double-cliquez sur 4 digital inputs_1.sds.
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10. Fenêtre principale > Onglet Linking > Physical Device : 
Cliquez sur l'icône correspondante.

ð La boîte de dialogue Choose physical channel s'ouvre.

11. Sélectionnez le premier module de la borne EL1904 et confirmez avec OK.

ð La borne EL1904 est connectée à l'Alias Device correspondant.

12. Onglet Linking > FSoE Address : 
L'adresse FSoE de la borne EL1904 a été automatiquement chargée dans TwinCAT XAE lors de la numérisation
matérielle, champ Dip Switch. Pour appliquer cette adresse, cliquez sur l'icône correspondante.

ð L'adresse est appliquée depuis le champ Dip Switch vers le champ FSoE Address.

13. Dans Solution Explorer, sélectionnez le dossier Alias Devices et double-cliquez sur 0xB1EC5956 – Safety(FSoE).sds.

14. Fenêtre principale > Onglet Linking > Physical Device : 
Cliquez sur l'icône correspondante.

ð La boîte de dialogue Choose physical channel s'ouvre.

15. Sélectionnez le premier module du servo-variateur avec le module de sécurité intégré SY6 et cliquez sur OK pour
confirmer.

ð Le servo-variateur est connecté à l'Alias Device correspondant.

16. Onglet Linking > FSoE Address : 
L'adresse FSoE du module de sécurité a été automatiquement chargée dans TwinCAT XAE lors de la numérisation
matérielle, champ Dip Switch. Pour appliquer cette adresse, cliquez sur l'icône correspondante.

ð L'adresse est appliquée depuis le champ Dip Switch vers le champ FSoE Address.

17. Onglet Connection > Watchdog (ms) : 
indiquez le temps du chien de garde.

18. Pour indiquer la temporisation SS1 après laquelle la fonction STO est automatiquement déclenchée, sélectionnez dans
la fenêtre principale > Onglet Safety Parameters > Paramètre  T_SS1.

19. T_SS1 :
double-cliquez sur l'entrée.

ð La boîte de dialogue Set Value s'ouvre.

20. Dec. :
entrez la temporisation SS1 comme multiple de 10 ms et confirmez en cliquant sur OK.

ð Les composants matériels sont connectés aux Alias-Devices correspondants et les adresses FSoE sont entrées.

Information

Indiquez la temporisation SS1 comme multiple de 10 ms. Un T_SS1 de 100 équivaut à 1 s (100 × 10 ms = 1 s).

Attribuez pour T_SS1 une valeur supérieure à celle du temps d'arrêt rapide du servo-variateur. En règle générale, la réserve
devrait être de 10 % et ne devrait pas être inférieure à 50 ms.

Information

Attribuez une valeur suffisamment grande au temps du chien de garde.

Observez la condition suivante :
S27 Safety durée du chien de garde > A258 EtherCAT PDO-Timeout + S26 FSoE temps de cycle + 26 ms.
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8.4.3.4 Configurer un bloc fonctionnel

Via le bloc fonctionnel safeEstop, configurez une touche d'arrêt d'urgence reliée à la borne d'entrée sûre EL1904 via deux
contacts à ouverture.

8.4.3.4.1 Créer un bloc fonctionnel et affecter les sources de signaux

2

54

1
3

Fig. 5: TwinCAT 3 – configurez le bloc fonctionnel « safeEstop » et affectez les sources de signaux

1. Dans Solution Explorer, naviguez vers votre projet SAFETY > TwinSafeGroup1 et double-cliquez sur
TwinSafeGroup1.sal (1).

2. Menu VIEW (2) : 
ouvrez l'affichage Toolbox.

3. Toolbox > FunctionBlocks (boolean) (3) : 
Glissez-déposez le bloc fonctionnel safeEstop dans la fenêtre principale > Onglet TwinSafeGroup1.sal.

4. Cliquez à gauche près de l'icône Restart.

5. Nommez la variable avec RestartInput.

6. Cliquez à gauche près de chaque icône EStopIn1 et EStopIn2.

7. Nommez les variables avec Channel1 et Channel2.

8. Cliquez à droite près de chaque icône EStopOut et EStopDelOut.

9. Nommez les variables avec Stop et StopVerz.

10. Delay Time (ms) : 
dans T_SS1  indiquez la temporisation SS1. 
Notez que la valeur dans ce champ d'entrée n'est PAS multipliée à l'intérieur du système par le facteur 10.

ð Toutes les variables nécessaires à la configuration du bloc fonctionnel safeEstop sont créées.
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11. Dans l'affichage Message, passez à l'onglet Variable Mapping > Sous-onglet Variables (4).

ð Les variables définies au préalable pour le bloc fonctionnel sont énumérées dans la colonne Assigned Variable.

12. Variable RestartInput > Colonne Alias Port : 
cliquez sur le bouton correspondant.

ð La boîte de dialogue Map to s'ouvre.

13. Usage : 
activez l'option Used and unused.

14. Affectez à la variable l'Alias Device ErrorAcknowledgement et confirmez avec OK.

15. Sous-onglet Variables > Variables Channel1 et Channel2 > Colonne Alias Port : 
Cliquez sur les boutons correspondants.

ð La boîte de dialogue Map to s'ouvre.

16. Affectez à la variable Channel1 l'Alias Device 4 digital inputs > Channel1 > InputChannel1 et la variable Channel2 
4 digital inputs > Channel2 > InputChannel2 et confirmez avec OK.

17. Sous-onglet Variables > Variables Stop et StopVerz > Colonne Alias Port : 
Cliquez sur les boutons correspondants.

ð La boîte de dialogue Map to s'ouvre.

18. Affectez à la variable Stop l'Alias Device 0xB1EC5956 - Safety (FSoE)  > Channel > SS1 et à la variable StopVerz l'Alias
Device 0xB1EC5956 - Safety (FSoE)  > Channel > STO et confirmez avec OK.

ð Toutes les variables configurées du bloc fonctionnel safeEstop sont connectées aux Alias Devices correspondants.

19. Passez au sous-onglet Group Ports (5).

20. Variables ErrAck et Run/Stop > Colonne Alias Port : 
cliquez sur les boutons correspondants.

ð La boîte de dialogue Map to s'ouvre.

21. Usage : 
activez l'option Used and unused.

22. Affectez à chaque variable un Alias Device ErrorAcknowledgement et RUN du groupe TwinSAFE et confirmez avec OK

ð Le bloc fonctionnel configuré est prêt pour le téléchargement vers le MainInstance FSoE.
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8.4.3.4.2 Transférer un bloc fonctionnel

Validez le bloc fonctionnel configuré et transférez-le vers le MainInstance FSoE.

1. Dans Solution Explorer, naviguez vers votre projet SAFETY > TwinSafeGroup1 et double-cliquez sur
TwinSafeGroup1.sal.

2. Sélectionnez le menu TWINSAFE > Verify Complete Safety Project.

3. Une fois la validation effectuée, l'état VERIFICATION PROCESS SUCCEEDED s'affiche à gauche du bas de page de l'interface
TwinCAT XAE.

4. Sélectionnez le menu TWINSAFE > Download Safety Project.

ð La boîte de dialogue Check if the addresses configured on hardware terminals [...] s'ouvre.

5. Confirmez la requête avec Yes.

ð La boîte de dialogue Download Project Data > Steps: Login s'ouvre. 
Le téléchargement vers le MainInstance FSoE est protégé par un mot de passe.

6. Zone Login :
dans le cas d'un appareil neuf, indiquez les données suivantes (accès par défaut TwinCAT) et confirmez avec Next : 
Username : Administrator
Serial Number : Numéro de série des MainInstances FSoE
Password : TwinSAFE

ð La boîte de dialogue Download Project Data > Steps: Download s'ouvre.

7. Cliquez sur Next pour lancer le téléchargement en aval.

ð La boîte de dialogue Download Project Data > Steps: Final Verification s'ouvre.

8. Zone Final Verification > Demande de confirmation  I have manually verified the data shown [...] :
vérifiez les données configurées, confirmez la demande de confirmation en activant la case correspondante et cliquez
sur Next.

ð La boîte de dialogue Download Project Data > Steps: Activation s'ouvre.

9. Zone Activation > Password : 
entrez à nouveau le mot de passe TwinSAFE et confirmez avec Finish.

ð Le bloc fonctionnel est transféré vers le MainInstance FSoE.

10. Redémarrez le système TwinCAT : 
sélectionnez le menu Actions > Set/Reset TwinCAT to Config Mode.

ð La boîte de dialogue Restart TwinCAT System in Config Mode s'ouvre.

11. Cliquez sur OK pour confirmer.
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8.4.4 Vérifier la fonctionnalité du groupe TwinSAFE
Vérifiez le bon fonctionnement du groupe TwinSAFE.

1. Dans Solution Explorer, naviguez vers votre projet SAFETY > TwinSafeGroup1 et double-cliquez sur
TwinSafeGroup1.sal (1).

2. Sélectionnez le menu TWINSAFE > Show Online Data.

ð Le MainInstance FSoE (borne EL6900) est à l'arrêt, le bloc fonctionnel safeEstop est désactivé, l'état correspondant
est défini sur Rouge.

3. Démarrez le groupe TwinSAFE via RUN = true.

4. Déverrouillez la touche d'arrêt d'urgence et appuyez sur la touche Reset.

ð Le bloc fonctionnel n'est pas actif, le groupe TwinSAFE ne fonctionne pas correctement.

8.5 Vérifier les fonctions de sécurité
Le module de sécurité SY6 est un composant de sécurité au sens de la Directive machines conformément à l'Annexe V. 
Il garantit la sécurité de fonctionnement, p. ex. vis-à-vis d'erreurs dans le logiciel et le micrologiciel. Toutefois, il ne garantit
ni la sécurité de l'ensemble du processus, ni celle de la configuration.

C'est au fabricant de la machine qu'il incombe de vérifier et de prouver la fonctionnalité des fonctions de sécurité utilisées.
L'essai des fonctions de sécurité est strictement réservé à un personnel qualifié. Le résultat de l'essai doit être documenté
dans un rapport d'essai.

L'essai de la fonction de sécurité doit être effectué...

§ après la première mise en service

§ après la modification de la configuration des fonctions de sécurité

§ après le remplacement du module de sécurité ou du servo-variateur

Un essai complet englobe...

§ l'exécution conforme des fonctions de sécurité utilisées du module de sécurité SY6

§ l'exécution conforme de la fonction de sécurité globale (p. ex. combinaison et intégration de fonctions de sécurité)

§ le contrôle des paramètres

L'essai repose sur...

§ les exigences vis-à-vis des fonctions de sécurité du module de sécurité SY6 à partir de l'analyse des risques de la
machine ou du processus

§ la description du module de sécurité SY6 et de ses fonctions de sécurité conformément au présent manuel

§ tous les paramètres de sécurité et toutes les valeurs des fonctions de sécurité utilisées

Le rapport d'essai doit contenir les éléments suivants :

§ une description de l'application comprenant une image

§ une description des composants de sécurité (y compris les versions logicielles) utilisés dans l'application

§ une liste des fonctions de sécurité utilisées

§ les résultats de tous les essais de ces fonctions de sécurité

§ une liste de tous les paramètres de sécurité et leurs les valeurs

§ les sommes de contrôle, la date des essais et la confirmation par le personnel chargé des essais
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Il est permis d'effectuer les essais de sécurité dans les applications de construction identique comme essai de type unique
de l'application de construction identique dans la mesure où la garantie peut être donnée que les fonctions de sécurité sont
configurées dans tous les appareils comme prévu.

Information

L'essai doit être répété et noté dans le rapport d'essai si des paramètres influençant les fonctions de sécurité ont été
modifiés.
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9 Diagnostic
En cas de dérangement, vous pouvez opter pour une des possibilités de diagnostic décrites ci-après.

9.1 Affichage DEL
Les servo-variateurs sont équipés de DEL de diagnostic qui visualisent l'état de la communication par bus de terrain ainsi
que les états de la connexion physique.

9.1.1 État EtherCAT
Deux DEL situées sur la face avant du servo-variateur informent de l'état de la connexion entre le MainDevice et le 
SubDevice EtherCAT et de l'état de l'échange de données. Celui-ci peut également être extrait du paramètre A255. Si le 
servo-variateur contient le module de sécurité SY6, les fonctions de sécurité sont contrôlées via EtherCAT FSoE. Dans 
ce cas, une DEL additionnelle placée sur la face avant de l'appareil informe sur l'état FSoE.

1
2

Err
Run
FSoE

Fig. 6: DEL indiquant l'état EtherCAT

1 Rouge : Error

2 Verte : Run

DEL rouge Comportement Erreur Description

Éteinte No Error Aucune erreur

Clignotement Invalid Configuration Configuration invalide

Clignote 1 fois Unsolicited State Change Le SubDevice EtherCAT a automatiquement
changé d'état de service

Clignote 2 fois Application Watchdog
Timeout

Le SubDevice EtherCAT n'a reçu aucune
nouvelle donnée PDO pendant la
temporisation paramétrée du chien de garde

Allumée Application controller
failure

Erreur de communication à l'intérieur de
l'appareil ; mettre l'appareil hors tension et
ensuite sous tension

Tab. 6: Signification des DEL rouges (Error)
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DEL verte Comportement État de service Description

Éteinte Init Aucune communication entre le MainDevice
et le SubDevice EtherCAT ; la configuration
démarre, le chargement des valeurs est
effectué

Clignotement Pre-Operational Aucune communication PDO ; le MainDevice
et le SubDevice EtherCAT échangent les
paramètres spécifiques aux applications par
SDO

Clignote 1 fois Safe-Operational Le SubDevice EtherCAT envoie les valeurs
réelles actuelles au MainDevice EtherCAT,
ignore ses valeurs de consigne et a plutôt
recours aux valeurs par défaut internes

Allumée Operational Fonctionnement normal : le MainDevice et le
SubDevice EtherCAT échangent les valeurs
de consigne et les valeurs réelles

Tab. 7: Signification de la DEL verte (Run)
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9.1.2 État FSoE (option SY6)
Si le servo-variateur est doté du module de sécurité SY6, les fonctions de sécurité STO et SS1 sont contrôlées via
EtherCAT FSoE. Dans ce cas, une DEL située sur la face avant de l'appareil informe sur l'état de la communication FSoE.
Celui-ci peut être également consulté dans le paramètre S20 FSoE indicateur d'état.

Err
Run
FSoE1

Fig. 7: DEL pour l'état FSoE

1 Verte : FSoE

DEL verte Comportement Description

Éteinte Initialisation

Clignotement Prêt pour le paramétrage

Allumée Fonctionnement normal

Flash simple Commande Failsafe reçue du MainInstance FSoE

Clignotement rapide Erreur de connexion indéfinie

Clignotement rapide
avec 1 clignotement

Erreur dans les paramètres de communication relatifs à la sécurité

Clignotement rapide
avec 2 clignotement

Erreur dans les paramètres d'application relatifs à la sécurité

Clignotement rapide
avec 3 clignotement

Adresse FSoE erronée

Clignotement rapide
avec 4 clignotement

Commande non autorisée reçue

Clignotement rapide
avec 5 clignotement

Erreur chien de garde

Clignotement rapide
avec 6 clignotement

Erreur CRC

Tab. 8: Signification de la DEL verte (FSoE status indicator conformément à CEI 61784-3)
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9.1.3 Connexion réseau EtherCAT
Les diodes électroluminescentes LA ECIN et LA ECOUT sur les bornes X200 et X201 sur le dessus de l'appareil indiquent l'état
de la connexion réseau EtherCAT.

LA
LA

IN
EC

X2
00

:
O

U
T

EC
X2

01
:

1

2

3

4

Fig. 8: Diodes électroluminescentes indiquant l'état de la connexion réseau EtherCAT

1 Vert : LA ECOUT à X201

2 Jaune : sans fonction

3 Vert : LA ECIN à X200

4 Jaune : sans fonction

DEL verte Comportement Description

Désactivé Aucune connexion réseau

Clignotement Échange de données actif avec d'autres participants EtherCAT

Activé Connexion réseau établie

Tab. 9: Signification des DEL vertes (LA)
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9.2 Paramètres
Les paramètres de diagnostic suivants sont disponibles dans le cadre de la technique de sécurité avec les servo-variateurs
de la gamme SC6 ou SI6 et le module de sécurité SY6.

9.2.1 E54 | Information module de sécurité | SI6 | V1
Caractéristiques clés du module de sécurité.

§ [0] : type

§ [1] : version du matériel

§ [2] : numéro de production

§ [3] : version de micrologiciel

§ [4] – [5] : réservés

§ [6] : code de diagnostic

9.2.2 E67 | État STO | SI6 | V3
État STO du module de sécurité :

§ [0] : STO est demandée
Source : liaison OU logique de E67[1] et E67[2], y compris une temporisation de mise hors tension

• 0: Inactif = pas demandée

• 1: Actif = demandée

§ [1] : STO demandée par le canal de sécurité 1
Source SR6 : borne X12.1/X12.2, signal STOa = 0

• 0: Inactif = pas demandée

• 1: Actif = demandée

§ [2] : STO demandée par le canal de sécurité 2
Source SR6 : borne X12.3/X12.4, signal STOa = 0

• 0: Inactif = pas demandée

• 1: Actif = demandée

La temporisation de mise hors tension est de 32 ms pour les modules de sécurité SR6, SY6 ou SU6.

Avec les modules de sécurité SR6, SY6 ou SU6, STO agit globalement, c'est-à-dire simultanément sur les deux axes pour les 
régulateurs double axe.
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9.2.3 S20 | FSoE indicateur d'état | SI6 | V2
État de la transmission de données de sécurité via FSoE.

Correspond au FSoE status indicator conformément à CEI 61784-3.

Normal

§ 0 hex = initialisation
Possible à l'état FSoE Pre-Reset

§ 1 hex = prêt pour le paramétrage par FSoE MainInstance
Possible dans les états FSoE Reset, Session, Connection, Parameter

§ 2 hex = fonctionnement normal
Possible à l'état FSoE Process Data

§ 3 hex = commande Failsafe reçue par FSoE MainInstance
Possible à l'état FSoE Failsafe Data

Erreur

§ 4 hex = erreur de connexion indéfinie
Possible dans tous les états FSoE

§ 5 hex = erreur dans les paramètres de communication relatifs à la sécurité
Possible dans le paramètre État FSoE

§ 6 hex = erreur dans les paramètres d'application relatifs à la sécurité
Possible dans le paramètre État FSoE

§ 7 hex = adresse FSoE erronée 
Possible à l'état FSoE Connection

§ 8 hex = commande inadmissible reçue via l'interface de communication FSoE
Possible dans tous les états FSoE

§ 9 hex = temporisation de la transmission des données (chien de garde)
Possible dans tous les états FSoE

§ A hex = transmission de données incohérente (somme de contrôle CRC)
Possible dans tous les états FSoE

9.2.4 S21 | FSoE adresse esclave | SI6 | V1
Adresse du servo-variateur (FSoE SubInstance) dans le réseau EtherCAT (condition préalable : FSoE MainInstance est actif ;
source : commutateurs DIP).

Les changements d'adresse sont appliqués au redémarrage du servo-variateur.
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9.2.5 S25 | Module de sécurité code de diagnostic | SI6 | V2
Octet d'état avec code de diagnostic du module de sécurité.

§ Bit 0 : erreur de canal OSSD interne

§ Bit 1 : réservé

§ Bit 2 : erreur de communication FSoE

§ Bit 3 : réservé

§ Bit 4 : surtempérature

§ Bit 5 : réservé

§ Bit 6 : temps SS1
0 = inactif ; 1 = actif

§ Bit 7 : état STO
1 = en état hors tension

Sauf indication contraire : 0 = inactif ; 1 = actif

9.2.6 S26 | FSoE temps de cycle | SI6 | V1
Temps de cycle FSoE mesuré.

S26 est la somme du temps de traitement dans FSoE SubInstance, du temps de traitement dans FSoE MainInstance et de la
durée de transmission PDO dans le réseau EtherCAT.

9.2.7 S27 | Safety durée du chien de garde | SI6 | V2
Durée de la défaillance tolérée de télégrammes FSoE pour la surveillance de la communication FSoE dans le réseau
EtherCAT (utilisation : déclenchement STO interne ; source : FSoE MainInstance).

La surveillance FSoE est généralement indépendante de la surveillance PDO et est prédéfinie par FSoE MainInstance
(surveillance PDO : A258).

Tenez toutefois compte de la condition suivante dans la pratique :

S27 Safety durée du chien de garde > A258 EtherCAT PDO-Timeout + S26 FSoE temps de cycle + 26 ms

9.2.8 S544 | Mot de commande safety | SI6 | V2
Octet de commande pour FSoE.

Correspond à l'objet de communication Mot de commande safety selon ETG.6100.3 ; objet 6620 hex.

SY6

§ [0] : premier octet
Correspond à l'objet de communication 1st byte selon ETG.6100.3 ; sous-index 1 hex

• Bit 0 : STO
0 = activer STO ; 1 = ne pas activer STO

• Bit 1 : SS1
0 = activer SS1 ; 1 = ne pas activer SS1

• Bits 2 – 7 : réservés

§ [1] – [5] : deuxième à sixième octets : réservés
Correspond aux objets de communication 2nd byte à 6th byte selon ETG.6100.3 ; sous-index 2 hex à 6 hex

Le bit 0 et le bit 1 doivent être définis sur 1 pour l'autorisation du bloc de puissance.
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9.2.9 S545 | Mot d'état Safety | SI6 | V2
Octet d'état pour FSoE.

Correspond à l'objet de communication Mot d'état Safety selon ETG.6100.3 ; objet 6621 hex.

SY6

§ [0] : premier octet
Correspond à l'objet de communication 1st byte selon ETG.6100.3 ; sous-index 1 hex

• Bit 0 : STO
1 = STO actif

• Bits 1 – 7 : réservés

§ [1] – [5] : deuxième à sixième octets : réservés
Correspond aux objets de communication 2nd byte à 6th byte selon ETG.6100.3 ; sous-index 2 hex à 6 hex

9.2.10 S593 | SS1 temps jusqu'à STO | SI6 | V0
Temporisation SS1, c.-à-d. durée entre l'activation d'un SS1 basé sur le temps par S544 Mot de commande safety, le bit 1 et
le déclenchement interne de la fonction STO (unité : 10 ms ; source : FSoE MainInstance).

Correspond à l'objet de communication SS1 temps jusqu'à STO selon ETG.6100.3 ; objet 6651 hex.

Un changement de la temporisation SS1 dans FSoE MainInstance prend effet avec le prochain redémarrage de FSoE
MainInstance et est visible dans le paramètre S593.
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9.3 Événements
Le servo-variateur est équipé d'un système d'auto-surveillance qui protège le système d'entraînement de dommages grâce
à des règles de contrôle. La violation des règles de contrôle déclenche un événement correspondant. En qualité
d'utilisateur, vous n'avez aucune influence sur certains événements, comme par exemple un Court-circuit/mise à la terre.
En revanche, vous pouvez influencer les incidences et les réactions d'autres événements.

Incidences possibles :

§ Message : information pouvant être analysée par la commande

§ Avertissement : information pouvant être analysée par la commande et qui se transforme en dérangement au bout
d'une période définie si la cause n'a pas été éliminée

§ Dérangement : réaction immédiate du servo-variateur ; le bloc de puissance est bloqué et le mouvement de l'axe n'est
plus contrôlé par le servo-variateur ou l'axe est immobilisé à la suite d'un arrêt rapide ou d'un freinage d'urgence

En fonction de l'événement, il existe différentes mesures que vous pouvez prendre pour en éliminer la cause. Une fois la
cause éliminée, vous pouvez en général acquitter directement l'événement. Si un redémarrage du servo-variateur s'impose,
vous trouverez une indication correspondante dans les actions à prendre.

PRUDENCE

Dommage matériel dû à l'interruption de l'arrêt rapide ou au freinage d'urgence !

Si un dérangement survient pendant l'exécution d'un arrêt rapide ou pendant un freinage d'urgence, ou si STO est activée,
l'arrêt rapide ou le freinage d'urgence sont interrompus. Dans ce cas, il y a risque d'endommagement de la machine dû à un
mouvement incontrôlé de l'axe.

Information

Afin de faciliter la configuration de l'interface utilisateur (HMI) aux programmeurs de la commande, servez-vous de la liste
des événements et de leurs causes disponible dans le centre de téléchargement STOBER à l'adresse 
http://www.stoeber.de/fr/download, critère de recherche Événements.

9.3.1 Événement 50 : Module de sécurité
Le servo-variateur bascule dans l'état en dérangement :

§ Le bloc de puissance est verrouillé et le servo-variateur ne contrôle plus le mouvement de l'axe

§ Le comportement des freins dépend de la configuration du module de sécurité

Information

Dans les états Mise en marche désactivée, Prêt à la mise sous tension et En marche (E48), un flanc montant est attendu
pour le signal Commande prioritaire de déblocage (source : F06), afin que le frein soit débloqué.

Cause Contrôle et mesure

2: Module sécurité erroné Le module de sécurité planifié E53
ne correspond pas au E54[0]
détecté par le système

Contrôlez la planification et le servo-variateur
et, le cas échéant, corrigez la planification ou
remplacez le servo-variateur ; le dérangement
n'est pas acquittable

3: Erreur interne Module de sécurité défectueux Remplacez le servo-variateur ; le dérangement
n'est pas acquittable

Tab. 10: Événement 50 – Causes et solutions

http://www.stoeber.de/fr/download
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9.3.2 Événement 70 : Consistance des paramètres
Le servo-variateur bascule dans l'état en dérangement :

§ Le bloc de puissance est verrouillé et le servo-variateur ne contrôle plus le mouvement de l'axe

§ Le comportement des freins dépend de la configuration du module de sécurité

Information

Dans les états Mise en marche désactivée, Prêt à la mise sous tension et En marche (E48), un flanc montant est attendu
pour le signal Commande prioritaire de déblocage (source : F06), afin que le frein soit débloqué.

Information

L'événement n'est déclenché qu'en cas de violation des règles de contrôle lors de l'Autorisation activée.

Cause Contrôle et mesure

Option SY6 :
15: Safety durée du chien de garde

Surveillance de la temporisation
PDO désactivée

Vérifiez la temporisation EtherCAT PDO dans le
servo-variateur et activez-la si nécessaire 
(A258 = 0 ou 65535)

Chien de garde SyncManager = 0 Vérifiez le chien de garde SyncManager
EtherCAT dans le MainDevice EtherCAT et
augmentez-le si nécessaire (A258 = 65534,
A259[0])

Rapport trop faible entre le temps
du chien de garde FSoE et la
temporisation EtherCAT PDO

Vérifiez le temps du chien de garde FSoE dans
le MainInstance FSoE et la temporisation PDO
EtherCAT dans le servo-variateur et augmentez
le temps du chien de garde ou réduisez la
temporisation si nécessaire (condition : temps
du chien de garde FSoE > temporisation PDO
EtherCAT + temps de cycle FSoE + 26 ms ; S27,
A258, S26)

Rapport trop faible entre le temps
du chien de garde FSoE et la
temporisation SyncManager
EtherCAT

Vérifiez le temps du chien de garde FSoE dans
le MainInstance FSoE et le chien de garde
SyncManager EtherCAT dans le MainDevice
EtherCAT et augmentez éventuellement le
temps du chien de garde ou réduisez le chien
de garde SyncManager (condition : temps du
chien de garde FSoE > chien de garde
SyncManager EtherCAT + temps de cycle FSoE +
26 ms ; S27, A258 = 65534, A259[0], S26)

Tab. 11: Événement 70 – Causes et mesures
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10 Plus d'informations sur FSoE, les fonctions de
sécurité et SY6 ?

Ce chapitre résume les principales notions, relations et mesures autour de FSoE, des fonctions de sécurité STO et SS1 ainsi
que du module de sécurité SY6.

10.1 FSoE : Fail Safe over EtherCAT
Il existe, à l'intérieur du système Ethernet en temps réel EtherCAT, un protocole Safety appelé Safety over EtherCAT (FSoE
= Fail Safe over EtherCAT) pour la transmission de messages de sécurité entre les appareils FSoE dans un réseau. Le
protocole fait l'objet d'une normalisation internationale dans la norme CEI 61784-3. La conception FSoE repose sur le
principe Black-Channel.

Communication sécurisée

Dans chaque cycle FSoE un MainInstance FSoE envoie des données de sécurité à un SubInstance FSoE et démarre
simultanément une horloge chien de garde. Le SubInstance FSoE acquitte les données reçues avant qu'elles ne soient
retournées au MainInstance et démarre également une surveillance de la durée de fonctionnement par l'horloge chien de
garde. Le MainInstance reçoit et traite l'acquittement des SubInstances et arrête l'horloge chien de garde. Si les données
ont été entièrement traitées, le MainInstance FSoE génère un nouveau paquet de données.

Adressage univoque

Chaque SubInstance FSoE doit être identifiable par une adresse FSoE univoque.

L'adresse est attribuée via les commutateurs DIP directement sur le servo-variateur. Une adresse valide est disponible dans
la plage d'adresses 1 – 255 (8 bits, adresse 0 ne doit en aucun cas être attribuée).
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10.2 Fonctions de sécurité
Le module de sécurité SY6 prend en charge les fonctions de sécurité Safe Torque Off (STO) et Safe Stop 1 (SS1-t). Pour
déplacer l'axe, la commande de sécurité doit définir aussi bien le bit de commande STO que le bit de commande SS1 du
servo-variateur. Si seul un des deux bits de commande est défini, le servo-variateur reste en état hors tension (STO active).

Les fonctions de sécurité se rapportent à l'appareil et ne sont pas spécifiques aux axes. Cela signifie que dans le cas de
variateurs multiaxe, seul le servo-variateur complet peut être défini dans l'état sûr, et non les axes individuellement.

10.2.1 Safe Torque Off – STO

t

t

t

t

n

On

1

1

Speed

Torque
on Motor

STO State

STO

Fig. 9: Principe de fonctionnement STO conformément à ETG.6100.2

STO selon EN 61800-5-2 correspond à la catégorie d'arrêt 0 conformément à EN 60204.

La fonction STO est la fonction de sécurité la plus fondamentale intégrée dans l’entraînement. La fonction STO empêche
l'effet d'une énergie génératrice de couple sur un moteur raccordé et un démarrage involontaire. L'objectif est l'exclusion
fiable de dommages corporels et matériels dus à un moteur en marche ou mis en service par inadvertance.

L'utilisation de la fonction STO convient pour les cas où le moteur s'arrête automatiquement en raison d'un couple de
charge ou par frottement dans un laps de temps suffisamment court – ou dans un environnement dans lequel un arrêt en
roue libre du moteur ne présente aucune importance du point de vue de la sécurité.
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10.2.2 Safe Stop 1 – SS1-t

t

t

t

t

t

t0 t1T_SS1

n

On

1

1

1

Speed

Torque
on Motor

SS1 State

STO State

SS1

Fig. 10: Principe de fonctionnement SS1-t selon ETG.6100.2

t0 Activation SS1

t1 Activation STO

T_SS1 Temporisation SS1

SS1 selon EN 61800-5-2 correspond à la catégorie d'arrêt 1 conformément à EN 60204-1.

Dans le cas de la fonction SS1-t, l'arrêt a lieu après une durée configurable.

La fonction de sécurité SS1-t permet la mise à l'arrêt contrôlée d'un moteur qu'elle met ensuite hors couple une fois la
temporisation SS1 paramétrée expirée, c.-à-d. que la fonction de sécurité STO est activée. Le déclenchement de la fonction
STO est temporisé, peu importe si le moteur est déjà à l'arrêt.

AVERTISSEMENT !

Surcourse prolongée ! Mouvement résiduel !

Le bloc de sécurité ne peut pas empêcher une défaillance de la partie fonctionnelle du servo-variateur (p. ex. en cas de mise
à l'arrêt commandée) pendant l'exécution de la fonction de sécurité SS1-t. D'où l'impossibilité d'utiliser SS1-t lorsque cette
défaillance est susceptible de provoquer une situation dangereuse dans l'application finale. Tenez compte de ce fait lors de
la planification.

En cas d'erreur dans le bloc de puissance du servo-variateur – bien que la fonction STO soit active – un passage de courant
statique est possible dans le moteur, l'arbre du moteur pouvant ici se déplacer, au maximum, de l'angle 360° ÷ (p × 2).

Information

Notez que durant la temporisation SS1, le servo-variateur continue de suivre les valeurs de consigne de la commande, ce
qui permet une mise à l'arrêt contrôlée dans le cas d'applications multiaxe.



STOBER 10 | Plus d'informations sur FSoE, les fonctions de sécurité et SY6 ?
08

/2
02

4 
| 

ID
 4

42
74

5.
04

59

La temporisation SS1 T_SS1 est un paramètre de sécurité. La valeur de T_SS1 est transmise de la commande de sécurité au
servo-variateur lors de l'initialisation de la communication.

Dans DriveControlSuite, la valeur de T_SS1 s'affiche dans le paramètre S593 SS1 temps jusqu'à STO.

10.3 SY6 : attribuer une adresse FSoE
Pour une identification univoque du module de sécurité SY6 dans le réseau FSoE, vous devez lui affecter manuellement une
adresse FSoE tirée de la plage d'adresses 1 – 255 via les commutateurs DIP S12 situés dans la partie supérieure du servo-
variateur. L'adresse 0 n'est pas valide, c.-à-d. que si l'adresse 0 est attribuée, la valeur est ignorée et le module de
sécurité SY6 reste dans l'état STO.

Information

Le servo-variateur doit être hors tension avant l'attribution de l'adresse du module de sécurité SY6 via les commutateurs
DIP S12. L'adresse est appliquée uniquement après un redémarrage du servo-variateur.

Attribuer une adresse via un commutateur DIP S12

Les commutateurs DIP pour l'attribution de l'adresse sont situés dans la partie supérieure du servo-variateur. L'adresse se
compose des valeurs des commutateurs DIP qui se trouvent sur ON. Le graphique ci-dessous montre les commutateurs
DIP S12.2 et S12.4 à l'état ON. L'adresse 10 résulte des valeurs correspondantes 2 et 8 des commutateurs DIP pour le
module de sécurité SY6.

8
1

2
3

4
5

6
7

O N

Fig. 11: SY6 – Commutateur DIP S12

Commutateur DIP S12 1 2 3 4 5 6 7 8

Valeur (adresse) 1 2 4 8 16 32 64 128

Tab. 12: Commutateur DIP S12 et valences

Vérifier l'adresse FSoE

Vous pouvez vérifier l'adresse FSoE que vous avez attribuée au module de sécurité SY6 via le paramètre S21 FSoE adresse
esclave dans DriveControlSuite.



10 | Plus d'informations sur FSoE, les fonctions de sécurité et SY6 ? STOBER

60

08
/2

02
4 

| 
ID

 4
42

74
5.

04

10.4 Temps du système de sécurité

Temps du système de sécurité

Capteur Entrée
sûre

MainInstance
FSoE

MainDevice
EtherCAT

MainDevice
EtherCAT

Communication Communication

Temps de réaction Temps de réaction Temps de réaction Temps de réactionTemps de réactionTemps de réaction

Servo-variateur

Fig. 12: Temps de réaction et temps du système de sécurité

On entend par temps du système de sécurité l'intervalle de temps qui s'écoule entre la requête d'une fonction de sécurité
sur un capteur et le déclenchement de la fonction de sécurité sur le servo-variateur.

Le temps du système de sécurité dépend des temps de réaction et des durées de communication et de transmission des
différents composants du système.

Les temps de réaction et de communication résultent du processus suivant :

§ capteur :
met à disposition le signal de demande

§ Entrée sécurisée :
détecte le signal de demande

§ MainDevice EtherCAT :
transfère l'état de l'entrée sécurisée vers le MainInstance FSoE

§ MainInstance FSoE :
analyse le signal de demande

§ MainDevice EtherCAT :
transfère le signal de demande vers le servo-variateur

§ Servo-variateur :
active la fonction de sécurité et s'arrête le cas échéant (temps d'arrêt STO) ; ce processus se divise en :

• traitement dans la pièce de commande

• transmission du paquet de données au module de sécurité SY6

• SY6 : analyse du paquet de données

• Temps d'arrêt du bloc de puissance

10.5 Temps du chien de garde
Afin de détecter d'éventuels dérangements, la communication entre le MainInstance et le SubInstance FSoE est surveillée
par un chien de garde FSoE. Une fois un télégramme FSoE envoyé, tant le MainInstance que le SubInstance démarrent ce
que l'on appelle le temps du chien de garde. Si le MainInstance ou le SubInstance ne reçoivent pas de télégramme de
réponse correspondant avant l'expiration du temps du chien de garde, l'appareil concerné passe dans un état hors tension.
Le temps du chien de garde est pris en compte dans le calcul du temps de réaction worst case.

Le temps du chien de garde est paramétré séparément pour chaque SubInstance dans le MainInstance FSoE.

Dans TwinCAT 3, un temps du chien de garde global de 100 ms est réglé par défaut. Si vous souhaitez changer ce temps par
défaut, passez, dans le cas de TwinCAT 3, aux propriétés des Alias Devices correspondants d'un groupe TwinSAFE.
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11 Annexe

11.1 Objets de communication pris en charge

11.1.1 ETG.6100.3 Safety over EtherCAT Drive Profile: 6600 hex – 67FF hex
Le tableau ci-après contient les objets de communication pris en charge du profil normalisé ETG.6100.3 Safety over
EtherCAT Drive Profile ainsi que leur reproduction sur les paramètres spécifiques STOBER.

Index Sous-
index

TxPDO PDO de
réception

Nom Commentaire

6600 hex 0 hex — — Time unit Unité : 10 ms

6620 hex Mot de commande safety Array avec 2 éléments

6620 hex 0 hex — — Highest subindex supported Valeur constante 2 hex

6620 hex 1 hex — — Mot de commande safety, 
1st byte

S544[0]

6620 hex 2 hex –
6 hex

— — Mot de commande safety, 
2nd – 6th byte

S544[1] – S544[5] ; 
sans fonction

6621 hex Mot d'état Safety Array avec 2 éléments

6621 hex 0 hex — — Highest subindex supported Valeur constante 2 hex

6621 hex 1 hex — — Mot d'état Safety, 
1st byte

S545[0]

6621 hex 2 hex –
6 hex

— — Mot d'état Safety, 
2nd – 6th byte

S545[1] – S545[5] ; sans fonction

6640 hex 0 hex — — STO command supported Fonction prise en charge = 1

6641 hex 0 hex — — STO restart acknowledge Redémarrage STO sans acquittement = 0

6650 hex 0 hex — — SS1 command supported Fonction prise en charge = 1

6651 hex 0 hex — — SS1 time to STO S593, unité définie dans l'objet 6600 hex

Tab. 13: Objets de communication ETG.6100.3: 6600 hex – 67FF hex
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11.1.2 ETG.5001.4 Safety over EtherCAT: E000 hex – EFFF hex
Le tableau ci-après contient les objets de communication pris en charge du profil normalisé ETG.5001.4 Safety over
EtherCAT.

Index Sous-
index

TxPDO PDO de
réception

Nom Commentaire

E901 hex FSoE Connection
Communication Parameter

Record avec 8 éléments

E901 hex 0 hex — — Highest subindex
supported

Valeur constante 8 hex

E901 hex 1 hex — — Version

E901 hex 2 hex — — FSoE SubInstance address

E901 hex 3 hex — — Connection ID

E901 hex 4 hex — ✓ Watchdog time

E901 hex 5 hex — — Reserved

E901 hex 6 hex — — Connection type

E901 hex 7 hex — — ComParameterLength

E901 hex 8 hex — — ApplParameterLength

F980 hex 0 hex — — FSoE SubInstance Address

Tab. 14: Objets de communication ETG.5001.4 : E000 hex – EFFF hex
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11.2 Informations complémentaires
Les documentations listées ci-dessous vous fournissent d'autres informations pertinentes sur la 6e génération de servo-
variateurs STOBER. Vous trouverez l'état actuel de la documentation dans notre centre de téléchargement sous :
http://www.stoeber.de/fr/download.
Entrez le n° ID de la documentation dans le champ de recherche.

Titre Documentation Contenus Nº ID

Servo-variateur SC6 Manuel Structure du système,
caractéristiques techniques,
planification, stockage, montage,
raccordement, mise en service,
fonctionnement, service après-
vente, diagnostic

442791

Système modulaire avec SI6 et PS6 Manuel Structure du système,
caractéristiques techniques,
planification, stockage, montage,
raccordement, mise en service,
fonctionnement, service après-
vente, diagnostic

442729

Communication EtherCAT – SC6,
SI6

Manuel Installation électrique, transfert de
données, mise en service,
diagnostic, informations
complémentaires

443026

Application CiA 402 – SC6, SI6 Manuel Planification, configuration,
paramétrage, essai de
fonctionnement, informations
complémentaires

443081

Informations complémentaires et sources sur lesquelles repose la présente documentation ou dont proviennent les
citations :

Beckhoff Automation GmbH & Co. KG (éditeur) : Documentation du système EtherCAT. Version 5.1. Édit. 2016.

Une version de base gratuite du logiciel d'automatisation TwinCAT 3 est disponible à l'adresse 
https://www.beckhoff.com/fr-fr/products/automation/twincat/te1xxx-twincat-3-engineering/te1000.html.

EtherCAT Technology Group (ETG), 2015. ETG.1300 : EtherCAT Indicator and Labeling. ETG.1300 S (R) V1.1.0. Spécification.
03/07/2015.

EtherCAT Technology Group (ETG), 2020. ETG.5001 : Modular Device Profile, Part 4: Safety Modules Specification.
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http://www.stoeber.de/fr/download
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11.3 Symbole de formule

Signes
convenus

Unité Explication

p – Nombre de paires de pôles

TM Année, a Temps de mission

11.4 Abréviations

Abréviation Signification

µC Microcontrôleur

CRC Cyclic Redundancy Check (contrôle de redondance cyclique)

CEM Compatibilité Électromagnétique

ESI EtherCAT SubDevice Information (description d'un SubDevice EtherCAT)

ETG EtherCAT Technology Group

EtherCAT Ethernet for Control Automation Technology

FSoE Fail Safe over EtherCAT

IGBT Insulated Gate Bipolar Transistor (transistor bipolaire à électrode de grille)

I/O Input/Output (entrée/sortie)

MInstance MainInstance

PDO Process Data Objects (objets de données process)

PDS(SR) Power Drive System(Safety Related) (entraînement de puissance à fonction de sécurité intégrée)

PDU Process Data Units (unités de données process)

PL Performance Level (niveau de performance)

PWM Pulse Width Modulation (modulation de largeur d’impulsion)

RxPDO Receive PDO (données process de réception)

SIL Safety Integrity Level (niveau d’intégrité de sécurité)

SIL CL Safety Inegrity Level Claim Limit (limite de revendication du niveau d’intégrité de sécurité)

API Automate Programmable Industriel

SRECS Safety Related Electrical Control System (système de commande électr. relatif à la sécurité d’une
machine)

SRP/CS Safety Related Part of a Control System (pièce relative à la sécurité d’une commande)

SS1 Safe Stop 1 (arrêt fiable 1)

SS1-t Save Stop 1-time (arrêt fiable 1, contrôlé par minuterie)

STO Safe Torque Off (absence sûre de couple)

SubInstance SubordinateInstance

TwinCAT The Windows Control and Automation Technology

TxPDO Transmit PDO (données process d'émission)
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12 Contact

12.1 Conseil, service après-vente, adresse
Nous nous ferons un plaisir de vous aider !

Vous trouverez sur notre site Web de nombreux services et informations concernant nos produits :
http://www.stoeber.de/fr/service

Pour tout renseignement complémentaire ou des informations personnalisées, n'hésitez pas à contacter notre service de
conseil et de support :
http://www.stoeber.de/fr/support

Vous avez besoin de notre System Support :
Tél. +49 7231 582-3060
systemsupport@stoeber.de

Vous avez besoin d'un appareil de rechange :
Tél. +49 7231 582-1128
replace@stoeber.de

Pour joindre notre assistance téléphonique 24°heures sur 24°:
Tél. +49 7231 582-3000

Notre adresse :
STÖBER Antriebstechnik GmbH + Co. KG
Kieselbronner Straße 12
75177 Pforzheim, Allemagne

12.2 Votre avis nous intéresse
Nous avons rédigé la présente documentation avec le plus grand soin afin de vous aider à étendre et perfectionner, de
manière profitable et efficiente, vos connaissances spécifiques à notre produit.

Vos suggestions, avis, souhaits et critiques constructives nous aident à garantir et perfectionner la qualité de notre
documentation.
Si vous désirez nous contacter pour une des raisons susmentionnées, n'hésitez pas à nous écrire à l'adresse :
documentation@stoeber.de

Nous vous remercions pour votre intérêt.
L'équipe de rédaction STOBER

http://www.stoeber.de/fr/service
http://www.stoeber.de/fr/support
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12.3 À l'écoute de nos clients dans le monde entier
Nous vous assistons avec compétence et disponibilité et intervenons dans plus de 40 pays :

STOBER AUSTRIA
www.stoeber.at
+43 7613 7600-0
sales@stoeber.at

STOBER CHINA 
www.stoeber.cn 
+86 512 5320 8850
sales@stoeber.cn

STOBER FRANCE 
www.stober.fr 
+33 478 98 91 80 
sales@stober.fr

STOBER Germany 
www.stoeber.de 
+49 4 7231 582-0
sales@stoeber.de

STOBER HUNGARY 
www.stoeber.de 
+36 53 5011140
info@emtc.hu

STOBER ITALY 
www.stober.it 
+39 02 93909570 
sales@stober.it

STOBER JAPAN 
www.stober.co.jp 
+81-3-5875-7583
sales@stober.co.jp

STOBER SWITZERLAND 
www.stoeber.ch 
+41 56 496 96 50 
sales@stoeber.ch

STOBER TAIWAN 
www.stober.tw 
+886 4 2358 6089 
sales@stober.tw

STOBER TURKEY 
www.stober.com 
+90 216 510 2290 
sales-turkey@stober.com

STOBER UK 
www.stober.co.uk 
+44 1543 458 858 
sales@stober.co.uk

STOBER USA 
www.stober.com 
+1 606 759 5090 
sales@stober.com
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Glossaire

Adresse FSoE

Chaque SubInstance FSoE possède une adresse qui l'identifie de manière univoque dans le réseau FSoE. L'adresse est 
généralement réglée directement sur l'appareil, par exemple via les commutateurs DIP. Dans un système FSoE il est 
possible de distinguer au maximum 65533 participants par leurs adresses. Dans le cas d'un adressage 16 bits, les 
adresses 0 ou 0000 hex et 65535 ou FFFF hex ne sont pas autorisées. Dans le cas d'un adressage 8 bits, la plage 
d'adresses 1 à 255 est disponible pour le module de sécurité SY6.

Catégorie

Conformément à la norme DIN EN ISO 13849-1 : classification des pièces relatives à la sécurité en ce qui concerne leur
résistance aux défaillances et leur comportement consécutif à une éventuelle défaillance. Une catégorie est atteinte en
fonction de la structure et de l’agencement des pièces, de leur détection des défaillances et / ou de leur fiabilité.
Désignations possibles des catégories, cela signifie que les classifications sont B, 1, 2, 3, 4.

Chien de garde

Fonction qui sert à la surveillance cyclique d'appareils, de liaisons ou du logiciel. Dans les appareils STOBER, le chien de
garde sert par exemple à la détection d'une panne de communication entre la commande et le servo-variateur et
réagit, dans le cas d'un dépassement du temps, lorsqu'aucun échange de données n'a eu lieu entre les appareils avec
l'expiration du temps du chien de garde.

Diffusion IPv4-Limited

Type de diffusion dans un réseau avec IPv4 (Internet Protocol Version 4). L'adresse IP 255.255.255.255 est indiquée
comme destination. Le contenu de la diffusion n'est pas transmis par un routeur et est par conséquent limité au propre
réseau local.

Domaine de diffusion

Réseau logique de périphériques réseau dans un réseau local qui atteint tous les participants par la diffusion.

Fail Safe over EtherCAT (FSoE)

Protocole pour la transmission de données de sécurité via EtherCAT, en utilisant un Maître FSoE et un nombre indéfini
d'Esclaves FSoE (c'est-à-dire les appareils dotés d'une interface Safety over EtherCAT). Ce protocole permet la
réalisation de la sécurité fonctionnelle via EtherCAT. Le FSoE et son implémentation sont certifiés TÜV et sont
conformes aux exigences SIL 3 conformément à la norme CEI 61508.

Fichier ESI

Fichier de description de l'appareil pour les Esclaves EtherCAT. Conformément à ETG.2000 : fichier XML qui contient
toutes les données pertinentes d'un participant EtherCAT dans le système EtherCAT, comme par exemple l'identité du
fabricant, de code produit, la version ou le numéro de production. Le Maître EtherCAT a besoin de ce fichier pour la
configuration du système EtherCAT.
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Fonction de sécurité

Conformément à DIN EN 61800-5-2 : fonction dotée d'une performance spécifique en matière de sécurité, exécutée
intégralement ou en partie par un PDS(SR) et qui garantit l'état hors tension d'une installation ou empêche la naissance
d'états dangereux dans l'installation.

Insulated Gate Bipolar Transistor (IGBT)

Transistor bipolaire à grille isolée. Élément de construction à semi-conducteurs et à quatre couches, qui est piloté via
une passerelle et combine les avantages des transistors bipolaires et des transistors à effet de champ. On emploie
principalement les IGBT dans le domaine de l’électronique de puissance. 

MainDevice EtherCAT

Appareil responsable de la gestion de réseau et organisant l'accès des participants au réseau au support commun. Il est
le seul participant au réseau à envoyer activement des télégrammes.

MainInstance FSoE

Appareil d'une connexion FSoE qui initialise la communication de sécurité. Il envoie un télégramme FSoE contenant les
sorties sécurisées. Un MainInstance FSoE peut gérer un ou plusieurs SubInstances FSoE.

Module de sécurité

Accessoire pour servo-variateurs qui permet l'utilisation des fonctions de sécurité.

Performance Level (PL)

Conformément à la norme DIN EN ISO 13849-1 : dimension de fiabilité d’une fonction de sécurité ou d’un module. Le
niveau de performance se mesure à l'aide d'une échelle, de a à e (du niveau de performance le plus faible au plus
élevé). Plus le niveau de performance est élevé, plus la fonction considérée est sûre et fiable. Le niveau de
performance peut être affecté à un niveau SIL défini. À l'inverse, il n'est pas possible de déduire le niveau de
performance à partir d'un niveau SIL.

Principe Black-Channel

Technique permettant la transmission de données sûres via des câbles de réseau ou de bus peu sûrs. Les composants
Safety peuvent transmettre les données de sécurité indépendamment du matériel au moyen d'un protocole sûr qui
tunnellise le canal réseau sous-jacent. Les erreurs de transmission possibles sont mentionnées dans les normes CEI
61784-3 et CEI 61508.

Probabilité de défaillance dangereuse par heure (PFHD)

Conformément aux normes DIN EN 61508/DIN EN 62061 : probabilité moyenne d'une défaillance dangereuse d’un
appareil par heure. Constitue, avec PFH, l’une des bases de calcul fondamentales de la fiabilité de la fonction de
sécurité d’appareils, la classification SIL.
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Process Data Objects (PDO)

Objets de communication dans un réseau CANopen ou EtherCAT qui transmettent les données telles que les valeurs de
consigne et les valeurs réelles, les instructions de commande ou les informations d'état en fonction d'un événement ou
d'une destination, de manière cyclique ou sur requête en temps réel. En général, les PDO sont échangés avec priorité
via le canal de données process. En fonction de la couche des différents participants, on distingue entre les PDO de
réception (RxPDO) et les PDO d'émission (TxPDO).

Safe Stop 1 (SS1)

Conformément à la norme DIN EN 61800-5-2 : procédé de mise à l'arrêt d'un PDS(SR). En ce qui concerne la fonction
de sécurité SS1, le PDS(SR) exécute l’une des fonctions suivantes : a) Déclencher et contrôler l'importance du
ralentissement moteur dans les limites définies et déclenchement de la fonction STO si la vitesse de rotation du
moteur est inférieure à une valeur limite définie (SS1-d), ou b) Déclencher et superviser l'importance du ralentissement
moteur dans les limites définies et déclenchement de la fonction STO si la vitesse de rotation du moteur est inférieure
à une valeur limite définie (SS1-r), ou c) Déclencher le ralentissement moteur et, après une temporisation spécifique à
l'application, déclenchement de la fonction STO (SS1-t). SS1(-t) correspond dans ce cas à la mise à l'arrêt contrôlée par
minuterie selon la norme CEI 60204-1, catégorie d'arrêt 1(-t).

Safe Torque Off (STO)

Conformément à la norme DIN EN 61800-5-2 : procédé pour l’immobilisation d’un PDS(SR). Avec la fonction de sécurité
STO, le moteur n’est pas alimenté en énergie pouvant provoquer une rotation (ou un mouvement avec un moteur
linéaire). Le PDS(SR) ne fournit pas d’énergie au moteur pouvant générer un couple (ou une force avec un moteur
linéaire). La fonction STO est la fonction de sécurité la plus fondamentale intégrée dans l’entraînement. Elle
correspond à la mise à l‘arrêt non contrôlée conformément à la norme DIN EN 60204-1, catégorie d’arrêt 0.

Safety Integrity Level (SIL)

Conformément à la norme DIN EN 61800-5-2 : probabilité de défaillance d’une fonction de sécurité. La classification SIL
comporte quatre niveaux, de 1 à 4 (du niveau le plus faible au plus élevé). Le SIL garantit une évaluation précise des
systèmes et sous-systèmes. Plus le SIL est élevé, plus la fonction considérée est sûre et fiable.

Safety Integrity Level Claim Limit (SIL CL)

SIL maximal pouvant être sollicité – par rapport aux limitations structurelles et à l’intégrité systématique de la sécurité
d’un sous-système SRECS. Un niveau SIL CL dépend de la tolérance aux anomalies du matériel (HFT) et de la proportion
de défaillance en sécurité des sous-systèmes (SFF).

SubDevice EtherCAT

Participant au réseau qui traite et transmet les télégrammes. Le dernier participant renvoie le télégramme à l'appareil
responsable de la gestion de réseau.

SubInstance FSoE

Participant au réseau d'une connexion FSoE qui reçoit et traite les sorties sécurisées et fournit les entrées sécurisées au
MainInstance. Un SubInstance FSoE est affecté à un MainInstance FSoE.
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Temps d’arrêt STO

Délai entre l'activation de la fonction de sécurité sur le module de sécurité et la désactivation sûre du bloc de
puissance du servo-variateur.

Temps d'arrêt rapide

Temps qui résulte, en fonction de l'application, de la décélération d'arrêt rapide et de la vitesse maximale.

Temps de mission (TM)

Conformément à la norme DIN EN 61800-5-2 : temps de fonctionnement cumulé défini du PDS(SR) pendant sa durée
de vie totale.

Temps de réaction worst case

Intervalle de temps maximal nécessaire pour couper l'actionneur en cas d'erreur.

Temps du chien de garde

Le temps avant l'expiration duquel un échange de données doit avoir eu lieu entre deux instances ou appareils. Si le
temps du chien de garde est dépassé sans qu'un échange de données n'ait eu lieu, le chien de garde se déclenche.
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